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Safety summary 1

The following general safety precautions must be observed during all 
phases of operation, service and repair of this equipment. Failure to comply 
with these precautions or with specific warnings elsewhere in this manual 
violates safety standards of design, manufacture and intended use of the 
equipment. Thrane & Thrane A/S assumes no liability for the customer's 
failure to comply with these requirements.

Observe marked areas
Under extreme heat conditions do not touch 
areas of the terminal or antenna that are 
marked with this symbol, as it may result in 
injury.

Microwave radiation hazards
During transmission the antenna in this system radiates Microwave 
Power.This radiation may be hazardous to humans close to the antenna. 
During transmission, make sure that nobody gets closer than the 
recommended minimum safety distance. 

On the SAILOR 500 FleetBroadband, the 
minimum safety distance on the focal line to 
the antenna panel is 1.3 m, based on a 
radiation level of 10 W/m2. The radiation level is 
100 W/m2 at a distance of 0.4 m from the 
antenna panel. Refer to the drawing on the 
next page.

On the SAILOR 250 FleetBroadband, the 
minimum safety distance on the focal line to 
the antenna panel is 0.6 m, based on a 
radiation level of 10 W/m2. The radiation level is 
100 W/m2 at a distance of 0.2 m from the 
antenna panel. Refer to the drawing on the 
next page.
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Distance to other equipment
Do not move the antenna closer to radars than the minimum safe distance 
specified in the installation manual - it may cause damage to the antenna. 
The equipment must be installed with the following minimum safe distances 
to magnetic steering compass: 

SAILOR FleetBroadband terminal: min. 0.3 m.
SAILOR 500 FleetBroadband antenna: min. 1.0 m
SAILOR 250 FleetBroadband antenna: min. 1.1 m

Service
User access to the interior of the terminal is prohibited. Only a technician 
authorized by Thrane & Thrane A/S may perform service - failure to comply 
with this rule will void the warranty. Access to the interior of the antenna is 
allowed, but only for replacement of certain modules - as described in the 
Installation manual. General service may only be performed by a technician 
authorized by Thrane & Thrane A/S.

Do not service or adjust alone
Do not attempt internal service or adjustments unless another person, 
capable of rendering first aid resuscitation, is present.

SAILOR 500:

MICROWAVE RADIATION
No personnel within safety distance

25° for SAILOR 500 

60° for SAILOR 250 

Safety distance:

(0.4 m, 100 W/m2)
1.3 m, 10 W/m2

SAILOR 250:

(0.2 m, 100 W/m2)
0.6 m, 10 W/m2



Grounding, cables and connections
To minimize shock hazard, the equipment chassis and cabinet must be 
connected to an electrical ground. Both terminal and antenna must be 
grounded to the ship. For further grounding information refer to the 
Installation manual.

Do not extend the cables beyond the lengths specified for the equipment. 
The cable between the terminal and antenna can be extended if it complies 
with the specified data concerning cable losses etc.

All cables for the SAILOR FleetBroadband system are shielded and should 
not be affected by magnetic fields. However, try to avoid running cables 
parallel to AC wiring as it might cause malfunction of the equipment.

Power supply
The voltage range is 10.5 - 32 V DC; 14 A - 5.5 A. It is recommended that the 
voltage is provided by the 24 V DC power bus on the ship. Be aware of high 
start-up peak current: 20 A@24 V, 5 ms.

If a 24 V DC power bus is not available, an external 115/230 VAC to 24 V DC 
power supply can be used.

Equipment ventilation
To ensure adequate cooling of the terminal, 5 cm of unobstructed space 
must be maintained around all sides of the unit (except the bottom side). 
The ambient temperature range of the terminal is: -25° to +55°C.   

Do not operate in an explosive atmosphere
Do not operate the equipment in the presence of flammable gases or fumes. 
Operation of any electrical equipment in such an environment constitutes a 
definite safety hazard.

Keep away from live circuits
Operating personnel must not remove equipment covers. Component 
replacement and internal adjustment must be made by qualified 
maintenance personnel. Do not replace components with the power cable 
connected. Under certain conditions, dangerous voltages may exist even 
with the power cable removed. To avoid injuries, always disconnect power 
and discharge circuits before touching them.

Failure to comply with the rules above will void the warranty!
v



Mandatory safety instructions to installers & 
users of SAILOR®250 FleetBroadband 2

Use only manufacturer or dealer supplied antenna.

Antenna minimum safe distance: 0.415 m.

Antenna gain 12.2 dBi referenced to isotropic.

The Federal Communications Commission has adopted a safety 
standard for human exposure to RF (Radio Frequency) energy, 
which is below the OSHA (Occupational Safety and Health Act) 
limits.

Antenna mounting

The antenna supplied by the manufacturer or radio dealer must 
not be mounted at a location such that during radio transmission, 
any person or persons can come closer than the above indicated 
minimum safe distance to the antenna i.e. 0.415 m.

To comply with current FCC RF Exposure limits, the antenna must 
be installed at or exceeding the minimum safe distance shown 
above, and in accordance with the requirements of the antenna 
manufacturer or supplier.

Base Station Installation: The antenna should be fixed-mounted 
on an outdoor permanent structure. RF Exposure compliance must 
be addressed at the time of installation.

Antenna substitution

Do not substitute any antenna for the one supplied or 
recommended by the manufacturer or radio dealer. You may be 
exposing person or persons to excess radio frequency radiation. 
You may contact your radio dealer or the manufacturer for further 
instructions.
vi



Warning

Maintain a separation distance from the antenna to a person(s) of 
at least 0.415 m.

You, as the qualified end-user of this radio device must control the 
exposure conditions of bystanders to ensure the minimum 
separation distance (above) is maintained between the antenna 
and nearby persons for satisfying RF Exposure compliance. The 
operation of this transmitter must satisfy the requirements of 
Occupational/Controlled Exposure Environment, for work-related 
use. Transmit only when person(s) are at least the minimum 
distance from the properly installed, externally mounted antenna.

Note Thrane & Thrane recommends a minimum safety 
distance of 0.6 m to the SAILOR 250 FleetBroadband 
antenna.
vii



About the manual 3

Intended readers

This manual is a user manual for the SAILOR 500 FleetBroadband 
system and the SAILOR 250 FleetBroadband system. The readers of 
the manual include anyone who is using or intends to use one of 
these two systems. No specific skills are required to operate the 
SAILOR FleetBroadband system. However, it is important that you 
observe all safety requirements listed in the beginning of this 
manual, and operate the system according to the guidelines in this 
manual. 

Manual overview

Note that this manual does not cover installation nor does it cover 
how to use the IP handset that comes with the system. For 
information on installation refer to the installation manual and for 
information on the IP handset refer to the user manual for the IP 
handset. Part numbers for both manuals are listed in the next 
section.

This manual has the following chapters:

• Introduction contains an overview of the BGAN services and a 
brief description of the system.

• Getting started explains how to insert SIM card and start up the 
unit. It also contains a short guide to making the first call.

• Operating the system explains how to use the system.

• Using the web interface explains how to use the built-in web 
interface of the terminal, and describes the available menus 
and settings, including advanced setup of interfaces.

• Troubleshooting contains a short troubleshooting guide and 
explains how to update software. It also describes the functions 
of the light indicators and the Reset button, and gives 
information on where to get further help if needed.
viii



This manual may not always reflect the latest software 
functionality of your terminal. To obtain the latest version of the 
manual, please enter the Thrane & Thrane Extranet and download 
the latest version, or acquire it from your distributor.

Related documents

The below list shows the documents related to this manual and to 
the SAILOR 500 FleetBroadband and SAILOR 250 FleetBroadband 
systems.

Title and description
Document 
number

SAILOR 500 FleetBroadband
SAILOR 250 FleetBroadband
Installation Manual

Explains how to install the 
SAILOR FleetBroadband terminal, the 
SAILOR 500 FleetBroadband antenna and the 
SAILOR 250 FleetBroadband antenna.

TT 98-125646

SAILOR 500/250 FleetBroadband, Quick Guide

A short guide to the most important functions 
of the SAILOR FleetBroadband systems.

TT98-125647

Thrane & Thrane IP Handset, User Manual

Explains the features and functions of the 
Thrane & Thrane IP handset. The IP handset 
works as a standard IP handset, but also serves 
as a user interface for the 
SAILOR FleetBroadband systems.

TT98-126059
ix



Typography

In this manual, typography is used as indicated below:

Bold  is used for the following purposes:

• To emphasize words. 
Example: “Do not touch the antenna”.

• To indicate what the user should select in the user interface. 
Example: “Select SETTINGS > LAN”. 

Italic  is used to emphasize the paragraph title in cross-references.

Example: “For further information, see Connecting Cables on 
page...”.

COURIER is used to indicate low level commands such as AT 
commands. 
Example: “In your terminal program, type ATD”.
x



Table of Contents

Safety summary ................................................................iii

Mandatory safety instructions to installers & users of 
SAILOR®250 FleetBroadband ............................................ vi

About the manual ............................................................ viii

Chapter 1 Introduction

Welcome ............................................................................ 1

In this chapter ....................................................................2

Features and interfaces ......................................................3

Main units ..........................................................................4
SAILOR®500 FleetBroadband/ SAILOR®250 FleetBroadband ......4
Units overview ......................................................................4
SAILOR FleetBroadband antennas ...........................................5
SAILOR FleetBroadband terminal ............................................7
IP handset and cradle ...........................................................9

The Inmarsat BGAN system ............................................... 11
What is BGAN? .................................................................... 11
The Inmarsat FleetBroadband service ..................................... 11
Coverage ............................................................................12
Overview of the FleetBroadband system ..................................13
The BGAN services ...............................................................14

Matrix of services and interfaces ......................................17

What’s next? .................................................................... 18

Chapter 2 Getting started

In this chapter ...................................................................19
xi



Table of Contents
Getting started with the terminal ..................................... 19
Operation at high temperatures ............................................ 19
Connector panel ................................................................ 20
Starting up the terminal ...................................................... 20

Connecting the IP handset ................................................22
Power supply ......................................................................22
Starting up the IP handset ....................................................22

Making the first data connection (LAN) .............................23
Before connecting to the LAN interface ..................................23
Connecting a computer to the LAN interface ...........................23

Entering the SIM PIN for the terminal ...............................24
Overview ............................................................................24
Entering the PIN using a phone or IP handset ........................24
Entering the PIN using the web interface ...............................26

Connecting to the BGAN network ......................................27

Making the first call .........................................................29
Introduction .......................................................................29
Making a call from the terminal ............................................29
Making a call to the terminal ................................................29
Making a call from one terminal to another ........................... 30

What’s next? ................................................................... 30

Chapter 3 Operating the system

In this chapter .................................................................. 31

General ............................................................................ 31
Tools for setup and use ........................................................ 31
Services and interfaces ........................................................33
xii



Table of Contents
Using a phone or fax machine .......................................... 34
Available interfaces ............................................................. 34
Selecting the call type .........................................................35
Making or receiving a phone call ..........................................38
Making a call to the terminal ................................................40
Dialing functions .................................................................41
Sending or receiving a fax message ......................................46

Using a computer .............................................................48
Available interfaces .............................................................48
Standard or Streaming data on LAN ......................................48
Working with network groups ..............................................50

Using the IP handset .........................................................51

What’s next? .....................................................................51

Chapter 4 Using the web interface

In this chapter ..................................................................53

Introduction .....................................................................53
The web interface ...............................................................53
Accessing and navigating the web interface ...........................55

Entering the SIM PIN in the web interface ........................58

The Dashboard .................................................................59
Overview ...........................................................................59
Properties ..........................................................................60
Managing data sessions .......................................................61

Using the phone book ......................................................65
General usage ....................................................................65
Editing phone book entries ..................................................68
Viewing and editing the mobile numbers ...............................69

Using the Call log .............................................................70
Information on total usage ...................................................70
Exporting the call log ...........................................................71
Viewing the lists of calls ...................................................... 72
xiii



Table of Contents
Handling messages ..........................................................73
Sending an SMS message ....................................................73
Options for messages in the Outbox .......................................74
Options for messages in the Sent folder .................................75
Sending an SMS message to the terminal ..............................75
Receiving a message ...........................................................76
Options for new SMS messages ............................................77
Options for SMS messages in the Inbox ..................................77
Configuring message settings ...............................................78

Setting up the interfaces .................................................. 80
The SETTINGS page (Antenna properties) .............................. 80
Enabling or disabling the L-Band interface ............................ 80
Configuring the LAN interface ............................................... 81
Configuring the Phone/Fax interface .................................... 85
Configuring the ISDN interface .............................................87
Setting the common interface settings .................................. 90
Setting up call services ........................................................92

Managing LAN network users ......................................... 99
Overview ........................................................................... 99
Setting up the network user groups ..................................... 100
Managing network devices ................................................. 104
The Network classification table .......................................... 106
Definitions for network terms .............................................. 109

Software upload and event log ......................................... 111
Uploading software ............................................................. 111
Viewing the Event list or the Event log .................................. 114

Selecting the preferred BGAN satellite ............................. 116

Administration ................................................................ 118
Accessing the administration settings ................................... 118
Call charges ......................................................................122
Log handling .....................................................................123
Using profiles ....................................................................124
Using traffic flow filters ...................................................... 128
Setting up user permissions ................................................ 131
xiv



Table of Contents
Help desk and diagnostic report ......................................133
Accessing the Help desk .....................................................133
Generating a diagnostic report ............................................134

What’s next? ...................................................................134

Chapter 5 Troubleshooting

In this chapter .................................................................135

Getting support ...............................................................135
Overview ..........................................................................135
Airtime support .................................................................135
System support ..................................................................135

Uploading software .........................................................136
Viewing software version status ...........................................136
Uploading software using the web interface ..........................136

Spare parts, SAILOR®500 FleetBroadband ...................... 137
Antenna spare parts ........................................................... 137
Cables .............................................................................. 137

Spare parts, SAILOR®250 FleetBroadband ......................138
Cables ..............................................................................138

Options and accessories ..................................................139

Troubleshooting guide ....................................................140

Status signaling ..............................................................146
Overview ..........................................................................146
Light indicators .................................................................146
Event messages .................................................................150

Logging of events ............................................................ 151
Diagnostic report ............................................................... 151
Event log .......................................................................... 151

Reset button ....................................................................152
How to access the Reset button ...........................................152
Function of the Reset button ...............................................153
xv



Table of Contents
Chapter 6 Conformity

SAILOR®500 FleetBroadband ......................................... 155
CE (R&TTE) ....................................................................... 155

SAILOR®250 FleetBroadband ...........................................157
CE (R&TTE) ........................................................................157
FCC ..................................................................................157

Glossary ....................................................................................... 159

Index ....................................................................................... 163
xvi



Chapter 1

1111

In
tro

du
ct

io
n

Introduction 1

Welcome

Congratulations on the purchase of your SAILOR FleetBroadband system!

SAILOR 500 FleetBroadband and SAILOR 250 FleetBroadband are maritime 
broadband systems, providing simultaneous high-speed data and voice 
communication via satellite through the Broadband Global Area Network 
(BGAN).
1



Chapter 1:  Introduction
Applications include:

• Internet browsing

• E-mail

• Phone and fax services

• Large file transfers

• Video conferencing and Streaming

• VPN (Virtual Private Network) access to corporate servers

In this chapter

This chapter introduces the SAILOR 500 FleetBroadband system and the 
SAILOR 250 FleetBroadband system, and gives an overview of the physical 
units and their features and functions.

It also gives an overview of the BGAN system and services.
2 In this chapter
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Features and interfaces

The SAILOR FleetBroadband system offers the following features and 
interfaces:

Simultaneous voice and data communication over BGAN

Full duplex, single or multi-user, up to:
SAILOR 500 FleetBroadband: 432 kbps
SAILOR 250 FleetBroadband: 284 kbps

Support for streaming IP at:
SAILOR 500 FleetBroadband: 32, 64, 128, 256 kbps
SAILOR 250 FleetBroadband: 32, 64, 128 kbps

ISDN service, only SAILOR 500 FleetBroadband: 64 kbps

Voice: Standard Voice (4.0 kbps) or 3.1 kHz Audio

4 LAN ports with Power over Ethernet (PoE) for computers, e-hubs, IP 
handsets etc.

2 Standard Phone/Fax ports for standard phones, fax machines or analog 
modems

1 Euro ISDN port for ISDN phones or, for SAILOR 500 FleetBroadband only: 
G4 fax or ISDN modem

1 L-Band output for connecting a broadcast receiver for maritime data

1 multi-purpose I/O connector with 5 configurable inputs/outputs

1 SIM slot for your BGAN SIM card

Integral DHCP/NAT router 

Built-in web interface allowing you to manage your phone book, 
messages and calls, and customize the terminal to your specific needs

Input power: 10.5 - 32 V DC (14 A - 5.5 A)

CE certified
Features and interfaces 3



Chapter 1:  Introduction
Main units

SAILOR®500 FleetBroadband/ SAILOR®250 FleetBroadband

The main difference between the SAILOR 500 FleetBroadband system and the 
SAILOR 250 FleetBroadband system lies in the antenna.

• SAILOR 500 FleetBroadband uses the TT-3052A antenna, which is a 
maritime BGAN Class 8 antenna. 
This antenna is larger and provides more bandwidth than the TT-3050A 
used for the SAILOR 250 FleetBroadband system.

• SAILOR 250 FleetBroadband uses the TT-3050A antenna, which is a 
medium size, maritime BGAN Class 9 antenna.

The SAILOR 500 FleetBroadband system and the SAILOR 250 FleetBroadband 
system basically use the same type of terminal, except that the 
SAILOR 500 FleetBroadband offers a few more features than the 
SAILOR 250 FleetBroadband. See Features and interfaces on page 3.

Units overview

The SAILOR 500 FleetBroadband system TT-3740A includes the following main 
units:

• TT-3052A SAILOR 500 FleetBroadband antenna

• TT-3738A SAILOR FleetBroadband terminal

• TT-3670A IP handset with cradle

The SAILOR 250 FleetBroadband system TT-3742A includes the following main 
units:

• TT-3050A SAILOR 250 FleetBroadband antenna

• TT-3738A SAILOR FleetBroadband terminal

• TT-3670A IP handset with cradle
4 Main units
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SAILOR FleetBroadband antennas

SAILOR®500 FleetBroadband antenna

SAILOR 500 FleetBroadband system uses the TT-3052A antenna, which is a 
maritime BGAN antenna that complies with Inmarsat’s Class 8 definition for 
maritime antennas. The antenna contains all functions for satellite tracking 
including a GPS system. A single coaxial cable carries all RF communication, 
supply voltage and modem communication between the antenna and the 
terminal.

This antenna is larger and provides more bandwidth than the TT-3050A used 
for the SAILOR 250 FleetBroadband system.
Main units 5



Chapter 1:  Introduction
SAILOR®250 FleetBroadband antenna

SAILOR 250 FleetBroadband system uses the TT-3050A antenna, which is a 
medium size, maritime BGAN Class 9 antenna.
6 Main units
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SAILOR FleetBroadband terminal

Overview

Whether you have purchased a SAILOR 500 FleetBroadband system or a 
SAILOR 250 FleetBroadband system, the terminal is basically the same. For 
this reason this section covers both systems.

The SAILOR FleetBroadband terminal is the controlling unit in the 
SAILOR FleetBroadband system. It contains all user interfaces and LED 
indicators and stores configuration data.

Tools for setup and daily use

The Thrane & Thrane IP handset is used for displaying status and for changing 
simple parameters. For information on how to use the handset menus, see the 
user manual for the IP handset.

The built-in web interface is used for easy configuration and daily use. The 
web interface is accessed from a computer connected to the terminal, using an 
Internet browser. No installation of software is needed.
For further information on the web interface, see Chapter 4, Using the web 
interface.
Main units 7



Chapter 1:  Introduction
SIM card

The terminal has a SIM slot (Subscriber Identity Module) located in the 
connector panel behind a small cover plate.

The terminal requires a dedicated FleetBroadband SIM card, which is acquired 
from your Airtime Provider.

The system requires a SIM card to go online and to access the settings of the 
terminal. However, using the web interface you can view the Dashboard and 
upload software without inserting a SIM card. Upload of software requires an 
Administrator user name and password.

For information of features and interfaces, see The Inmarsat BGAN system on 
page 11.
8 Main units
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IP handset and cradle

IP handset

The Thrane & Thrane IP handset 
communicates using Internet protocols. The 
handset is not strictly dedicated to the 
SAILOR FleetBroadband system, but can also 
be used in a public network as a standard IP 
telephone. 

When the IP handset is used with the 
terminal, it communicates using Internet 
protocol between the handset and the 
terminal. However, on the BGAN network 
side of the terminal, calls are transmitted as 
circuit switched calls.

The IP handset is powered directly from the 
LAN interface using Power over Ethernet 
(PoE).

When connected to the terminal the IP 
handset provides a dedicated menu with a 
subset of the terminal configuration options. 

For more information on the functions of the 
IP handset, refer to the user manual for the 
IP handset.
Main units 9



Chapter 1:  Introduction
IP cradle

The IP cradle serves as a holder for the IP handset. 

The handset is connected to the cradle with a coil cord. The cradle connects to 
the terminal using an Ethernet cable.
10 Main units
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The Inmarsat BGAN system

What is BGAN?

The Broadband Global Area Network (BGAN) is a mobile satellite service that 
offers high-speed data up to 492 kbps and voice telephony. BGAN enables 
users to access e-mail, corporate networks and the Internet, transfer files and 
make telephone calls.

The Inmarsat FleetBroadband service

FleetBroadband is a maritime communications service offered in the BGAN 
system. Based on 3G standards, FleetBroadband provides cost-effective 
broadband data and voice simultaneously.
The Inmarsat BGAN system 11



Chapter 1:  Introduction
Coverage

The Inmarsat BGAN services are based on geostationary satellites situated 
above the equator. Each satellite covers a certain area (footprint). The 
coverage map below shows the footprints of the BGAN system.

(Launch date 
to be finalized) 

Note The map depicts Inmarsat's expectations of coverage, but does not 
represent a guarantee of service. The availability of service at the 
edge of coverage areas fluctuates depending on various conditions.

The launch date of the F3 satellite (POR) will be determined in due 
course.

Note Certain FleetBroadband services are not available in areas with low 
elevation. For further information, see Limitations on page 16.
12 The Inmarsat BGAN system
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Overview of the FleetBroadband system

A complete BGAN FleetBroadband system may include the 
SAILOR FleetBroadband terminal with connected peripherals, a 
SAILOR 500 FleetBroadband antenna or a SAILOR 250 FleetBroadband 
antenna, the BGAN satellite, and the Satellite Access Station (SAS). The 
satellites are the connection between your terminal and the SAS, which is the 
gateway to the worldwide networks (Internet, telephone network, cellular 
network, etc.).

IP Router
PC

Switch Standard voic
and ISDN

SAILOR
FleetBroadband

Satellite Access Station
(SAS)

Satellite

Packet Switched Networ

Circuit Switched Network

SAILOR 500
FleetBroadband
antenna

terminal

IP Handset

SAILOR 250
FleetBroadband
antenna
The Inmarsat BGAN system 13
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The BGAN services

Supported services

The services currently supported by BGAN comprise:

• A Packet Switched connection to the Internet

• A Circuit Switched (Dialed) connection for voice, fax or data

• Short Messaging Service (SMS)

Packet data service

The BGAN network supports different classes of data connection to the 
Internet. 

• Using a Standard data connection several users can share the data 
connection simultaneously. This type of connection is ideal for e-mail, file 
transfer, and Internet and intranet access. The user pays for the amount of 
data sent and received.

• Using a Streaming data connection you get an exclusive high-priority 
connection ensuring seamless transfer of data. This type of connection is 
ideal for time critical applications like live video over IP. The user pays for 
the duration of the connection (per minute charge).

Note The BGAN system supports maximum 11 concurrent PS connections 
at a time per SAILOR FleetBroadband system.
14 The Inmarsat BGAN system
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Circuit switched (dialed) service

Two types of circuit switched connection are available:

• Standard Voice. A low-tariff connection for voice only. The voice signal is 
compressed to 4.0 kbps, which reduces the bandwidth use and 
consequently the tariff.

• 3.1 kHz Audio. A high quality connection which can be used for Premium 
Voice, G3 fax or analog modems. The signal is uncompressed 3.1 kHz 
audio, which allows for optimum voice quality.

• ISDN. A high quality connection which can be used for voice (3.1 kHz 
Audio), G4 fax or 64 kbps UDI/RDI data. 

SMS service

The BGAN system provides a Short Messaging Service (SMS) for sending and 
receiving SMS messages.

Supplementary services

The BGAN system also provides the following supplementary services:

• Call hold

• Call waiting

• Call forwarding

• Voice mail

• Call barring

Note The BGAN system only supports one CS call at a time per 
SAILOR FleetBroadband system.
The Inmarsat BGAN system 15
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Limitations

SIM lock

The supplier may SIM lock the terminal to a specific provider. For further 
information, contact your supplier.

Limitations in available services

The services available depend on your airtime subscription. Your SIM card 
may not allow for all the services described in this manual.

Further, for FleetBroadband Class 9, the following limitations apply:

For FleetBroadband Class 8, Streaming 256 kbps can only be guaranteed in 
elevations > 15°.

Service Elevation < 15 15 < Elevation < 20 Elevation ≥ 20

3.1 kHz Audio 
for voice and 
fax

Not supported Not supported Supported

ISDN Not supported Not supported Not supported

Standard IP Up to 284 kbps Up to 284 kbps Up to 284 kbps

Streaming 32, 64 kbps 32, 64, 128 kbps 32, 64, 128 kbps

Note The SAILOR 250 FleetBroadband system is a FleetBroadband Class 9 
system.

The SAILOR 500 FleetBroadband system is a FleetBroadband Class 8 
system.
16 The Inmarsat BGAN system



Chapter 1:  Introduction

1111

In
tro

du
ct

io
n

Matrix of services and interfaces

The following table shows which services can be accessed from which 
interfaces on the terminal, and which types of equipment can be used.

Service
Interface on the terminal

Phone/Fax LAN (PoE) ISDN

Ci
rc

ui
t S

w
itc

he
d

3.1 kHz 
Audioa

Analog 
telephone

IP handset ISDN telephone

G3 Fax machine G3 Fax machine

Computer with 
analog modem

Standard 
Voice

Analog 
telephone

IP handset ISDN telephone

Data, UDIa 
or RDI

a. Notes for SAILOR 250 FleetBroadband: UDI data is not available. In low 
elevations (< 20°), 3.1 kHz Audio is not available.

G4 fax machine 
or computer with 
ISDN modem

Pa
ck

et
 S

w
itc

he
d Data

multi-user
Computer

Data
single-

user

Computer

SMS Computer with 
web interface
Matrix of services and interfaces 17
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What’s next?

This chapter has provided an overview of the BGAN system and of the 
SAILOR FleetBroadband systems. 

The next chapters will go into more detail about how to set up and use your 
system. The following chapter, Getting started, explains how to start up the 
system. 
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In this chapter

This chapter describes how to start up the system and make the first call or 
data session.

For information on how to install the system, insert SIM card and connect 
cables, refer to the installation manual for the SAILOR 500 FleetBroadband 
and SAILOR 250 FleetBroadband systems.

Getting started with the terminal

Operation at high temperatures

In very high ambient temperatures, do not touch areas of 
the terminal that are marked with this symbol. 

If the terminal is installed in a location where the ambient temperature may 
rise above 50°C, we recommend placing the terminal where unintentional 
contact is avoided. Note that the maximum allowed ambient temperature is 
55° C.

If the maximum ambient temperature does not exceed 50°C, the terminal can 
be placed in a public area.

For further information on installation, refer to the installation manual for the 
SAILOR FleetBroadband systems.
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Connector panel

The drawing below shows the connector panel of the terminal. 

For information on how to connect to each interface, refer to the installation 
manual for the SAILOR 500 FleetBroadband and SAILOR 250 FleetBroadband 
systems.

Starting up the terminal

SIM card

Note that the SAILOR FleetBroadband terminal requires a SIM card dedicated 
to FleetBroadband. The terminal can only access the BGAN network when the 
right type of SIM card is installed. For information on how to insert the SIM 
card, refer to the installation manual.

Grounding stud

Power
switch

I/O

DC input

4 x LAN w. PoE

SIM slot

L-Band ISDNPhone 1Antenna

Reset button

Phone 2
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Switching on the terminal

To switch on the terminal, use the Power switch in the connector panel. It 
normally takes one or two seconds for the terminal to switch on.

If a switch for the remote on/off function is installed, you may leave the power 
switch in the “on” position and use the remote switch to turn the terminal on 
and off. For further information on the remote on/off function, refer to the 
installation manual for the SAILOR FleetBroadband systems.

When the terminal is switched on, the Power indicator in the LED panel of the 
terminal lights green. 

You can now access the terminal settings, but the terminal is not ready for 
making calls or running data sessions until the system is registered on the 
BGAN network. This normally requires that you enter a SIM PIN. For further 
information, see Entering the SIM PIN for the terminal on page 24 and 
Connecting to the BGAN network on page 27.

To switch off the terminal tip the Power switch back, or use the remote on/off 
function mentioned above. It takes 5 to 10 seconds to power down the 
terminal. 
Getting started with the terminal 21
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Connecting the IP handset

Power supply

The Thrane & Thrane IP handset is powered from the LAN interface, using 
Power over Ethernet.

Starting up the IP handset

The following procedure is for the Thrane & Thrane IP handset. The procedure 
may be different for another type of IP handset.

Do as follows:

1. Connect the Thrane & Thrane IP handset to one of the LAN (PoE) 
connectors on the terminal as described in the user manual for the 
handset.
The handset starts up automatically.

2. If the PIN has not been entered in the terminal, you can enter the PIN from 
the IP handset from the BGAN menu of the handset. If your SIM card uses 
a PIN, you cannot connect to the terminal until the PIN is entered.
To enter the PIN, enter the BGAN menu, type in the Administrator user 
name and password followed by the PIN for the terminal.

For further information on the IP handset, refer to the user manual for the 
handset.
22 Connecting the IP handset



Chapter 2:  Getting started

2
2

Ge
tti

ng
 s

ta
rt

ed
2
2

Making the first data connection (LAN)

Before connecting to the LAN interface

For the LAN (Local Area Network) interface to work without any further setup, 
the computer must be set up to obtain an IP address and a DNS server address 
automatically. 

Connecting a computer to the LAN interface

Do as follows:

1. Power up your computer.

2. Connect your LAN cable between the network connector on your computer 
and one of the LAN connectors on the terminal.

3. When the computer and the terminal are ready, check the connection e.g. 
by accessing the built-in web interface of the terminal with your browser. 
For further information, see Accessing the web interface on page 55.
You may have to disable the Proxy server settings in your browser. For 
further information, see Browser settings on page 54.

For information on how to configure the LAN interface on the terminal, see 
Configuring the LAN interface on page 81.
Making the first data connection (LAN) 23
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Entering the SIM PIN for the terminal

Overview

Depending on your SIM card, you may have to enter a SIM PIN to use the 
system. You can enter the PIN using a standard phone or ISDN phone, the IP 
handset or the web interface. Note that you always have to enter the PIN at 
start-up if the system has been powered off.

For information on how to connect the IP handset or computer you are going 
to use, see Connecting a computer to the LAN interface on page 23 or 
Connecting the IP handset on page 22.

Entering the PIN using a phone or IP handset

If you have a phone connected to the terminal, you can use it to enter the PIN 
at start up.

Do as follows:

Dial the PIN the same way you would dial a phone number:

• For an analog or ISDN phone: 
Pick up the phone. When the terminal is waiting for a PIN, you will hear 2 
beeps - pause - 2 beeps - etc.
Dial <PIN> followed by #.
When you hear a “busy” tone or a dialing tone, the PIN has been accepted 
and you can hang up or dial a number.

• For an IP handset: 
Select the BGAN menu, select Enter PIN and enter the user name and 
password for the terminal. Then enter the PIN for the terminal.

Wrong PIN

Analog phone or ISDN phone: If, instead of the busy tone or dialing tone, you 
continue to hear 2 beeps - pause - 2 beeps - etc., it means the PIN was not 
accepted. Check that you have the correct PIN and try again.
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If a wrong PIN has been entered three times, you will hear 3 beeps - pause - 3 
beeps - etc. This means you have to enter the PUK (PIN Unblocking Key) 
provided with your SIM card. 
After entering the PUK, you must enter a new PIN of your own choice (4 to 8 
digits long).

Dial the following:

<PUK> * <New PIN> * <New PIN> followed by # or off-hook key.

Example: If the PUK is 87654321 and the new PIN is 1234, dial
87654321 * 1234 * 1234 followed by # or off-hook key.

If you enter 10 wrong PUKs, the SIM card will no longer be functional. Contact 
your Airtime Provider for a new SIM card.

IP handset: After having entered the user name and password for the terminal 
you have 3 attempts to enter the SIM PIN, before you are asked to enter the 
PUK (Pin Unblocking Key). The PUK is supplied with your terminal SIM card. 

Enter the PUK followed by a new PIN of your own choice. The PIN must be 
from 4 to 8 digits long.

If you enter a wrong PUK 10 times, the SIM card will no longer be functional, 
and you have to contact your Airtime Provider for a new SIM card.
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Entering the PIN using the web interface

Do as follows:

1. On a computer connected to the terminal, open your browser and enter 
the IP address of the terminal. Refer to Using the web interface on page 53.
The default IP address is 192.168.0.1.
If your SIM card uses a PIN and the PIN has not yet been entered, the web 
interface will open on the PIN page.

2. Type in the PIN and click OK.
When the PIN is accepted, the web interface opens the Dashboard and is 
ready for use. If the PIN is not accepted, see the next section Wrong PIN.

Wrong PIN

You have 3 attempts to enter the PIN, before you are asked to enter the PUK 
(Pin Unblocking Key). The PUK is supplied with your SIM card. 
Enter the PUK followed by a new PIN of your own choice. The PIN must be 
from 4 to 8 digits long.

If you enter a wrong PUK 10 times, the SIM card will no longer be functional, 
and you have to contact your Airtime Provider for a new SIM card.
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Connecting to the BGAN network

When the SIM PIN is accepted by the terminal, the SAILOR FleetBroadband 
system starts the connection procedure on the BGAN network. 

You can monitor the connection procedure by looking at the Antenna and 
Terminal indicators in the LED panel of the terminal.

Note that this procedure may take several minutes. 

The table on the next page shows the normal sequence. 

Note We recommend keeping the vessel on a steady course while the 
antenna is performing a sky scan. If the vessel is turning during sky 
scan, it increases the total duration of the sky scan process.
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This table shows how the startup procedure is signaled with the light 
indicators. If errors occur, the indicators will light yellow or red, depending on 
the severity of the errors.

For further information on the indicators, see Light indicators on page 146.

Status Antenna indicator Terminal indicator

The antenna is starting up Flashing slowly green

The antenna is 
performing a sky scan

Flashing rapidly green

The terminal is 
registering on the 
network

Flashing green

The antenna is tracking. Steady green

The system is registered 
and ready for use.

Steady green Steady green
28 Connecting to the BGAN network
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Making the first call

Introduction

When the Antenna and Terminal indicators in the LED panel on the terminal 
both light steady green, you are ready to make or receive the first call.

The following sections provide a short guide to making calls. For more 
detailed information, see Making or receiving a phone call on page 38.

Making a call from the terminal

To make a call from a phone or handset connected to the terminal, dial

00 <country code> <phone number> followed by # or off-hook key (# on 
analog phones and ISDN phones, off-hook key on IP handsets).

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an 
analog phone, 
dial 00 45 39558800 #

Making a call to the terminal

To make a call to a phone connected to the terminal, dial

+ <Mobile number>

• + is the prefix used in front of the country code for international calls. This 
is 00 when calling from most countries in Europe and from many other 
countries.

Note By default all handsets connected to the terminal will ring on 
incoming calls. If you have connected a fax, set the incoming call 
type on that Phone/Fax interface to 3.1 kHz Audio to avoid that the 
fax rings and answers an incoming Standard call. For further 
information, see Selecting the call type on page 35
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• Mobile number: The mobile number of the terminal you are calling. The 
first part of the number is always 870, which is the “country code” for the 
BGAN system.

Example: If you are calling from Denmark and the mobile number for 3.1 kHz 
Audio is 870782105234 on your terminal, and you want to make a 
call to the terminal using 3.1 kHz Audio, dial 00 870 782105234.

If the mobile numbers are listed in the web interface, you can look them up by 
selecting PHONE BOOK > Mobile numbers. 

If the numbers are not listed, refer to your airtime subscription. We 
recommend using the web interface to save the mobile numbers for future 
reference. See Viewing and editing the mobile numbers on page 69.

Making a call from one terminal to another

To make a call from one terminal to another, 
dial 00 <Mobile number>.

Unanswered calls

You can see unanswered calls under CALLS > Missed calls in the web 
interface. 

What’s next?

After reading this chapter you should be able to start up the terminal and 
make a simple data or voice connection.

The next chapters provide more information on the user interfaces and the 
setup of the terminal. The following chapter, Operating the system, explains 
how to use the system

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice.
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Operating the system 3

In this chapter

This chapter describes how to use the SAILOR FleetBroadband systems.

It does not describe advanced configuration of interfaces. For this type of 
information, refer to the “Configuring...” sections for the data interfaces in 
Chapter 4, Using the web interface.

General

Tools for setup and use

Overview

You can use the Thrane & Thrane IP handset for viewing status, using the 
phone book of the terminal and for entering the PIN, but for enhanced use 
and for configuration of interfaces, you need to connect a computer.

With a computer and a browser, you can use the built-in web interface to set 
up the terminal.
31



Chapter 3:  Operating the system
The IP handset

When you connect the Thrane & Thrane IP handset to one of the LAN (PoE) 
connectors on the terminal you can use the handset display and keypad to 
enter the PIN or to view the status of the terminal. 

The IP handset includes the following items for the terminal:

• Viewing C/No (signal strength) and UMTS status (“Ready”, “Registering” 
etc.) for the SAILOR FleetBroadband system

• Entering the PIN and PUK for the terminal

• Inclusion of the terminal phone book (not editable) in the IP handset 
Contacts.

For further information on the IP handset, see the user manual for the IP 
handset.

The web interface of the terminal

The web interface is a built-in web server for setting up and controlling the 
terminal, using a connected computer with a browser. No installation of 
software is required. 

With the web interface you can access the same settings as with the IP 
handset, and additionally:

• edit the phone book

• view properties of the terminal and antenna

• set up the interfaces of the terminal

• upload software

With an administrator password you can also:

• set up user rights

• set up network user groups

For information on how to use the web interface, see Using the web interface 
on page 53.
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Services and interfaces

The following table shows the possible combinations of services and 
interfaces, and which types of equipment can be used.

Service
Interface on the terminal

Phone/Fax LAN (PoE) ISDN

Ci
rc

ui
t S

w
itc

he
d

3.1 kHz 
Audioa

Analog 
telephone

IP handset ISDN telephone

G3 Fax machine G3 Fax machine

Computer with 
analog modem

Standard 
Voice

Analog 
telephone

IP handset ISDN telephone

Data, UDIa 
or RDI

a. Notes for SAILOR 250 FleetBroadband: UDI data is not available. In low 
elevations (< 20°), 3.1 kHz Audio is not available.

G4 fax machine 
or computer with 
ISDN modem

Pa
ck

et
 S

w
itc

he
d Data

multi-user
Computer

Data
single-

user

Computer

SMS Computer with 
web interface
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Using a phone or fax machine

Available interfaces

Three types of voice equipment connect to the terminal:

Standard analog phone or G3 fax machine: The terminal has two phone 
connectors for connecting standard analog phones or fax machines.

IP handset: The terminal has four LAN connectors with Power over Ethernet for 
connecting IP handsets or other IP equipment. For information on the features 
and functions of the Thrane & Thrane IP handset, refer to the user manual for 
the handset.

ISDN phone or G4 fax machine: The terminal has one ISDN connector for 
connecting an ISDN phone, a modem or a fax machine. Note that only 
SAILOR 500 FleetBroadband supports G4 fax (UDI).

For information on how to connect to the interfaces, see the installation 
manual for the SAILOR 500 FleetBroadband and SAILOR 250 FleetBroadband 
systems.

Port 1 Port 2
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Selecting the call type

Definition

The phone connection can use one of the following call types:

• Standard Voice, which is a low-tariff voice connection compressed to 
4.0 kbps,

• 3.1 kHz Audio, which is a high quality connection used for Premium Voice, 
G.3 fax or analog modem,

• UDI or RDI (only on ISDN interface), which is used for G4 fax or data.

In the web interface you can set up which type of connection to use by default 
when you make or receive a call from the Phone/Fax or ISDN interface.

When connecting a fax or a modem to the Phone/Fax interface you must use 
3.1 kHz Audio.

Example: If you always have a fax connected to the same Phone/Fax 
interface you can set this interface to 3.1 kHz Audio only. This will 
mean that if an incoming Standard Voice call is received, this 
Phone/Fax interface will not ring.

When connecting a G4 fax or a modem to the ISDN interface in the 
SAILOR 500 FleetBroadband system you must use UDI.

Selecting the default outgoing call type

To select the default call type for outgoing calls, do as follows:

• ISDN. Select the call type in the web interface under SETTINGS > ISDN. 
For further information, see Configuring the ISDN interface on page 87.

• Phone/Fax. Select the call type for each port in the web interface under 
SETTINGS > Phone/Fax. 

Note UDI and RDI are not available with the SAILOR 250 FleetBroadband 
system, so you cannot connect a G4 fax machine nor a modem to the 
ISDN interface on the SAILOR 250 FleetBroadband system.
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For further information, see Configuring the Phone/Fax interface on 
page 85.

• IP handset. Currently not possible. The default call type is Standard Voice. 
However, using a prefix before the dialed number, you can override the 
default outgoing call type as explained below.

Overriding the default outgoing call type

To override the default setting for a specific outgoing call, do as follows:

• To use Standard Voice for the call,
dial 1* before the number. 

• To use 3.1 kHz Audio for the call,
dial 2* before the number.

Example: To make a call to Thrane & Thrane in Denmark (+45 39558800), 
forcing the connection to use Standard Voice, dial 1* 0045 
39558800 followed by # if calling from an analog or ISDN phone, 
or off-hook key if calling from an IP handset.

Note This will not change the default call type, only the type used for the 
ongoing call.
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Phone numbers for incoming 3.1 kHz Audio and Standard Voice

3.1 kHz Audio and Standard Voice have separate phone numbers. This way, a 
person calling a phone connected to the terminal can select whether to use 3.1 
kHz Audio or Standard Voice, simply by using the dedicated phone number.

If the mobile numbers are listed in the web interface, you can look them up as 
follows:

Connect a computer, access the web interface, select PHONE BOOK > Mobile 
numbers. For further information, see Viewing and editing the mobile numbers 
on page 69.

If the mobile numbers are not available in the web interface, refer to your 
airtime subscription.

For information on how to make a call to the terminal, see Making a call to the 
terminal on page 40.

Selecting the incoming call type

To select which call types are accepted for an incoming call, use a computer 
and the web interface.

• ISDN. Select the call type under SETTINGS > ISDN. 
For further information, see Configuring the ISDN interface on page 87.

• Phone/Fax. Select the call type for each port under SETTINGS > Phone/Fax. 
For further information, see Configuring the Phone/Fax interface on 
page 85.

• IP handset. Currently not possible. The default call type is Standard Voice.

Note The call type you are using must be selected in the web interface 
(refer to the next section).

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice.
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Making or receiving a phone call

Analog phone, ISDN phone or IP handset

There are different methods for activating a call, depending on the type of 
phone:

• Analog phone or ISDN phone: Dial # after the number.

• IP handset: Press the off-hook key after the number.

Making a call

First connect your phone to the relevant interface. For further information, see 
the Installation Manual.

You have different options for making a call:

• Short Dial. If the number is in the phone book of the terminal, you can use 
the Short Dial number, which is found in the first column of the phone 
book in the web interface. See Short dial on page 67.
Simply dial 00 <Short Dial> followed by # or off-hook key.

Example: To call entry number 4 in the phone book, 
dial 004 followed by # or off-hook key.

• Manual Dial. To make a call, dial
00 <country code> <phone number> followed by # or off-hook key.

Example: To call Thrane & Thrane in Denmark (+45 39558800) from an 
analog or ISDN phone, dial 00 45 39558800 #

• Call from phone book or call log (only IP handset). 

• Enter the phone book of the IP handset, scroll to the wanted number 
and press the off-hook key, or

• press the off-hook key from the main screen to display the latest calls 
in the call log. Then scroll to the wanted number and press the off-
hook key again.

If there was an error establishing the connection, refer to the Troubleshooting 
Guide on page 142.
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If you are using the IP handset, the handset may show an error message.
Depending on the type of error, the web interface may also show an error 
message. See Viewing the Event list or the Event log on page 114.

Receiving a call

To be able to receive a call, the phone must be connected to the relevant 
interface on the terminal. 

By default, all devices connected to the Phone/Fax interface, the ISDN 
interface or the LAN with PoE interface will ring when one of the mobile 
numbers is called. Note, however, that this depends on the call type settings. 
Refer to Selecting the incoming call type on page 37.

Call log

Information of missed calls is stored in the call log of the terminal. You can 
view the call log in the web interface under CALLS. For further information, 
see Viewing the lists of calls on page 72.
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Making a call to the terminal

To make a call to a phone connected to the terminal, dial 

+ <Mobile number>

• + is the prefix used in front of the country code for international calls. This 
is 00 when calling from countries in Europe and from many other 
countries.

• Mobile number. The first part of the mobile number is always 870, which is 
the “country code” for the BGAN system. If the mobile numbers are listed 
in the web interface, you can look them up as follows:
Connect a computer, access the web interface and select PHONE BOOK > 
Mobile numbers. For further information, see Viewing and editing the 
mobile numbers on page 69.
If the mobile numbers are not available in the web interface, refer to your 
airtime subscription.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice.
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Dialing functions

Special-purpose numbers

There are a number of dialing functions available in the terminal. The 
following list shows the allocated special-purpose numbers for the terminal.

Number Function

0 * followed by # or off-hook key Redial last called number on this interface.

00 * followed by # or off-hook key Redial last answered call on this interface.
Note: If the last answered number is an 
unlisted number, you will not be allowed to 
dial back.

00 followed by one of the numbers 
1-199 and # or off-hook key

Short dial phone numbers in phone book.

0300 followed by # or off-hook key Local call broadcast to both analog phones.

0 followed by one of the numbers 
301-302 and # or off-hook key 

Local call to analog phone. 

0400 followed by # or off-hook key Local call broadcast to all ISDN phones.

0 followed by one of the numbers 
401-402 and # or off-hook key

Local call to ISDN phone.

0500 followed by # or off-hook key Local call broadcast to all IP handsets.

0 followed by one of the numbers 
501-516 and # or off-hook key

Local call to IP handset.

0900 followed by # or off-hook key Local call broadcast to all handsets.
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Dialing prefixes

Apart from the numbers above, the terminal uses the following dialing 
prefixes:

• 1* before the phone number will force the connection to use Standard 
Voice.

• 2* before the phone number will force the connection to use 3.1 kHz 
Audio.

• #31# before the phone number will hide the callers phone number to the 
recipient.

• *31# before the phone number will show the callers phone number to the 
recipient where it would otherwise be hidden, e.g. because the number is 
an ex-directory number.

• R is used during a call to indicate that the following key-presses should 
activate a supplementary services function. The supplementary services 
functions supported by the terminal are described in the subsequent 
sections.

Making local phone calls

You can make local calls between various phones connected to the terminal.

Local phone numbers always start with 0.

For an overview of the numbers, see Special-purpose numbers on page 41.

To make a local call, dial
<local number> followed by # or off-hook key.

Local numbers of analog phones, ISDN phones and IP handsets are assigned 
according to the table in Special-purpose numbers on page 41. Note that if you 
are using local numbers for ISDN devices, the numbers must be programmed 
in the devices. For further information refer to the documentation for your 
ISDN device.
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Handling waiting calls

During a call, if a second party attempts to make contact with you, you may 
hear a Call Waiting indication. The Call Waiting indication is two beeps and a 
pause of 3 seconds, then two beeps again etc. If no action is taken, the waiting 
call is released after a time out period.

In the web interface you can enable or disable the call waiting indication. For 
further information, see Call waiting on page 95.

When you receive a Call Waiting indication, you have the following options:

Note The phone must have an R key to be able to use these functions.

If you want to: Do as follows:

Clear the current call,
and accept the waiting call.

Press R 1 #, within the time out period.

Hold the current call,
and accept the waiting call.

Press R 2 #, within the time out period.

Ignore the waiting call. Take no action.

Reject the waiting call. Press R 0 #, within the time out period.

Note The BGAN system only supports one external call at a time.
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Holding a call

During a call, you may place the initial call on hold while another call is made. 

Note The phone must have an R key to be able to use these functions.

If you want to: Do as follows:

Place a call on hold. Press R 2 #.

Place the existing call on 
hold and establish a new 
call.

Press R and dial the second phone number 
followed by #.

Shuttle between the two 
calls.

Press R 2 #
(irrespective of whether the second call was 
acquired using Call Hold or acceptance of 
Call Waiting.)

Clear the held call, if no 
waiting call exists.

Press R 0 #.

Clear an active call and 
return to the held call.

Press R 1 #. 
Note that this is only possible if no waiting 
call exists.

Note The BGAN system only supports one external call at a time.
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Transferring a call

When you receive a call, you can transfer this call to another phone connected 
to the terminal.

To transfer the incoming call to another phone or headset, do as follows:

1. Press R 4 * <local number> #.
The phone with the local number you dialed starts to ring. 

2. You now have two options.

• Hang up. The phone or headset you transferred the call to continues to 
ring. When the call is answered, a connection is established between 
the initial caller and the new recipient.

• Do not hang up. When the new recipient answers, you can have a 
conversation before hanging up. When you hang up, the call is handed 
over to the initial caller.

Note The phone must have an R key to be able to use these functions.

Note The BGAN system only supports one external call at a time.
Using a phone or fax machine 45



Chapter 3:  Operating the system
Sending or receiving a fax message

Handling delays

When sending or receiving fax messages over satellite, both fax units must be 
capable of handling longer delays without timing out. Some fax machines 
have an Overseas mode, which enables the unit to handle the long delays.

Sending a fax message from the terminal

The fax machine must be connected to the Phone/Fax interface or the ISDN 
interface of the terminal. Refer to the installation manual.

3.1 kHz Audio must be used for an analog fax machine. Refer to Selecting the 
default outgoing call type on page 35.

UDI must be used for an ISDN G4 fax machine, Note that this is not possible in 
a SAILOR 250 FleetBroadband system. Refer to Configuring the ISDN interface 
on page 87. 

To send a fax from a fax machine connected to the terminal, dial 
00 <country code> <phone number> #

Example: To send a fax to Thrane & Thrane in Denmark (+45 39558888), 
dial 00 45 39558888 #

Note If the default setting in the web interface is not 3.1 kHz Audio, you 
can dial 2 * before the number, to force the connection to use 3.1 kHz 
Audio. For further information, see Overriding the default outgoing 
call type on page 36.
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Sending a fax message to the terminal

To send a fax message to the terminal, dial

+ <Mobile number> #

• + is the prefix used in front of the country code for international calls. This 
is 00 when calling from countries in Europe and from many other 
countries.

• Mobile number. The first part of the mobile number is always 870, which is 
the “country code” for the BGAN system. Use the 3.1 kHz mobile number if 
you are calling a G3 fax and the UDI number if you are calling an ISDN G4 
fax connected to the terminal. If the mobile numbers are listed in the web 
interface, you can look them up as follows:
Connect a computer, access the web interface and select PHONE BOOK > 
Mobile numbers. For further information, see Viewing and editing the 
mobile numbers on page 69.
If the mobile numbers are not available in the web interface, refer to your 
airtime subscription.

Receiving a fax message

An analog fax machine connected to the terminal can only receive a fax with 
3.1 kHz Audio. Refer to Selecting the incoming call type on page 37.

An ISDN G4 fax machine connected to the SAILOR 500 FleetBroadband 
terminal can only receive a fax with UDI. SAILOR 250 FleetBroadband does not 
support UDI and cannot be used with a G4 fax machine.

Note There are four mobile numbers, one for 3.1 kHz Audio, one for 
Standard Voice, one for UDI and one for RDI.
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Using a computer

Available interfaces

The terminal has four LAN connectors for connecting computers or other LAN 
equipment.

For information on how to connect to the interfaces, see the installation 
manual for the SAILOR 500 FleetBroadband and SAILOR 250 FleetBroadband 
systems.

Standard or Streaming data on LAN

Definition

The BGAN network supports different classes of data connection to the 
Internet. The main classes are Standard data and Streaming data.

• Using a Standard data connection, several users can share the data 
connection simultaneously. This type of connection is ideal for TCP/IP 
traffic such as e-mail, file transfer, and Internet and intranet access. 
The user pays for the amount of data sent and received.

• Using a Streaming data connection, you get an exclusive, high-priority 
connection, ensuring seamless transfer of data. This type of connection is 
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ideal for time critical applications like live video over IP.
The user pays for the duration of the connection (per minute charge).

You can set up various types of connection using the profiles and traffic flow 
filters. For further information, see Using profiles on page 124 and Using traffic 
flow filters on page 128.

Setting up and activating a Streaming connection

The SAILOR 250 FleetBroadband system supports 32, 64 and 128 kbps 
Streaming.

The SAILOR 500 FleetBroadband system supports 32, 64, 128 and 256 kbps 
Streaming.

By default, any data connection on the terminal is a Standard data connection.

If you want to set up a Streaming connection, select a Streaming profile when 
setting up your network user group. See Managing LAN network users on 
page 99. 

To start or stop a Streaming session on the LAN interface, do as follows:

1. Access the web interface.

2. In the Dashboard, locate the field STREAMING PROFILES ON LAN.

Note For optimum performance it is important that you select the right 
traffic class when defining profiles for your connection. 

Note You may have difficulties establishing the fastest Streaming 
connection if you are located close to the edges of the satellite beam. 
256 kbps Streaming on SAILOR 500 FleetBroadband and 128 kbps 
Streaming on SAILOR 250 FleetBroadband normally require an 
elevation angle of more than 15 degrees.
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3. Click the Start or Stop link of the relevant Streaming profile. 

For further information, see Using profiles on page 124 and Setting up the 
network user groups on page 100.

Working with network groups

The LAN users of the SAILOR FleetBroadband system can be organized in 
network user groups with different setup and different access rights. 

Each user can only see and start/stop the profiles configured for the network 
user group he/she belongs to.

Using the built-in web interface with an Administrator password you can 
configure the network user groups and network devices.

For further information, see Managing LAN network users on page 99.

Note If another primary profile is active you must stop it before you 
can start your new profile.

Note When running a Streaming session you are charged for the time 
you are connected. A started Streaming session will stay active 
until you stop it.
50 Using a computer



Chapter 3:  Operating the system3

Op
er

at
in

g 
th

e 
sy

st
em
3
3

3

Using the IP handset

You can use the Thrane & Thrane IP handset as user interface for the 
SAILOR FleetBroadband system as well as for making calls.

The IP handset has a dedicated menu for the SAILOR FleetBroadband system.

For information on how to start up the IP handset, see Connecting the IP 
handset on page 22.

For further information on how to use the IP handset, refer to the IP Handset 
User Manual.

What’s next?

This chapter has described the basics of how to use the 
SAILOR FleetBroadband system.

The following chapter, Using the web interface, describes how to use the built-
in web interface for setting up and using the system.
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Using the web interface 4

In this chapter

This chapter describes how to use the web interface to operate, set up and 
configure your SAILOR FleetBroadband system.

Introduction

The web interface

What is the web interface?

The web interface is built into the terminal, and is used for operating, setting 
up and configuring the system. 

You can access the web interface from a computer with a standard Internet 
browser. Internet Explorer 6.0, Mozilla Firefox 1.0 and Apple Safari 2.0 have 
been tested successfully with the web interface. You may be able to use other 
browser versions as well.

Connecting

Connect your computer to the terminal, using the LAN interface. For 
information on how to connect to the LAN interface, see the installation 
manual.

To access the web interface, an Internet browser must be installed on the 
computer. 
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Browser settings

If you are connecting your computer using the LAN interface, the Proxy server 
settings in your browser must be disabled before accessing the web interface.

Most browsers support disabling of the Proxy server settings for one specific IP 
address, so you can disable Proxy server settings for the web interface only, if 
you wish. Consult your browser help for information.

To disable the use of a Proxy server completely, do as follows:

1. In Microsoft Internet Explorer, select Tools > Internet Options > 
Connections > LAN Settings.

2. Uncheck the box labeled Use a proxy server for your LAN. 

3. Click OK.

Note The following description is for Microsoft Internet Explorer. If you 
are using a different browser, the procedure may be different.
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When the proxy server settings are disabled, close your browser.

You may need to change this setting back on return to your Internet 
connection.

Accessing and navigating the web interface

Accessing the web interface

To access the web interface, do as follows:

1. Connect your computer to the terminal.

2. Start up the terminal. 
For further information, see Getting started on page 19.

3. Open your browser and enter the IP address of the terminal.
The standard IP address is 192.168.0.1.

Note If the IP address is changed and you do not have the new address, 
you can temporarily set the IP address to the default value by 
pressing the Reset button next to the SIM slot in the connector panel 
of the terminal. You can then access the web interface and change 
the IP address.

Note that if you do not change the IP address, the default IP address 
will only be valid until the terminal is powered off. Then the terminal 
returns to the IP address from before the Reset button was pressed. 

For further information on the Reset button, see Reset button on 
page 152.
Introduction 55



Chapter 4:  Using the web interface
Overview of the web interface

When the web interface opens, the title bar shows the name of the product. 

The web interface consists of the following sections.

• The navigation pane holds the main menu. Clicking an item in the menu 
opens a submenu in the navigation pane or a new page in the contents 
section.

• The status field shows the signal strength.

• The icon bar shows icons for new SMS messages and for active events, 
when relevant. For explanations of the icons, see the next section, Icons in 
the icon bar.

• The contents section shows the page selected in the navigation pane. This 
section is used for viewing or changing settings, or for performing actions.

Note If no antenna is connected, the web interface will assume that the 
system is a SAILOR 500 FleetBroadband system. 

Navigation

Status

Icon bar Contents section

pane

field

Title bar
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Icons in the icon bar

The following icons may appear in the icon bar in the web interface:

Navigating the web interface

• To expand a menu, click the menu in the navigation pane. 

• To access status and settings, click the relevant subject in the navigation 
pane or click the relevant icon in the icon bar. The status or settings are 
displayed in the contents section.

• To see the site map, click SITE MAP in the navigation pane. Click on items 
in the site map to go directly to the relevant location.

Icon Explanation

A new SMS message, or information of Voice mail, has arrived.

Click the icon to see new messages or information of Voice mail. 
For further information, see Receiving a message on page 76.

An event is active.

Click the icon to see a list of active events. For explanations of the 
event messages, see Logging of events on page 151.

Note that this icon will remain in the icon bar as long as the 
event is still active.
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Entering the SIM PIN in the web interface

If a computer is connected when you start up the terminal, you can access the 
web interface and enter the SIM PIN here.

If your SIM card requires a PIN: Until you enter the PIN you can only upload 
software and view the Dashboard. Access to all other parts of the web 
interface requires a PIN.

Type in the PIN and click OK.

If you enter a wrong PIN 3 times you are asked for a PUK (PIN Unblocking 
Key). For further information, see Wrong PIN on page 26.

If the PIN has already been entered in the terminal, or the PIN is disabled, the 
web interface goes directly to the Dashboard at start-up. 

When the correct PIN is entered, the web interface opens the Dashboard and 
is ready for use.

Note Some parts of the web interface may be greyed out if the user 
permissions are limited. For information on how to set up user 
permissions, see Setting up user permissions on page 131.
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The Dashboard

Overview

The Dashboard is used for control and inspection of ongoing communication 
and for viewing properties and status of the terminal and antenna.
The Dashboard 59



Chapter 4:  Using the web interface
Properties

The PROPERTIES section of the DASHBOARD shows the following information:

• Airtime provider. The name of your Airtime Provider.

• GPS position. The GPS position of your SAILOR FleetBroadband system.

• Status. The status of the terminal and antenna.
Examples of status information are: Scanning, Ready and Data active.

• Satellite selection. The satellite selected for logon. For further information, 
see Selecting the preferred BGAN satellite on page 116.

• Unit serial number. The serial number of the terminal.

• Software version. The version of the software embedded in the terminal.

• Local IP address. The local IP address of the terminal. This is the IP 
address used to access the terminal from a device connected to the 
terminal.

• IMEI number. The IMEI number (International Mobile Equipment Identity) 
of the terminal. This is a unique number that identifies your terminal.

• MAC address for the LAN interface in the terminal.

• Antenna. The type of antenna connected to the terminal, and the status of 
the antenna.
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Managing data sessions

Overview

Data sessions are displayed under PROFILES ON LAN or STREAMING PROFILES 
ON LAN at the bottom of the Dashboard.

• Primary profiles are listed in the left side and secondary profiles (if any) 
are listed to the right.

• Profiles that are currently active are displayed as a link with the text “Stop 
<name of profile>”. 

• Profiles that are ready to be activated are displayed as a link with the text 
“Start <name of profile>”. 
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Start/stop a Streaming session on the LAN interface

To start or stop a Streaming session, click the link with the name of your 
Streaming profile under STREAMING PROFILES ON LAN.

Note that if another primary profile is active you must stop it before you can 
start your new profile!

If a primary profile is already active, your new profile will not appear as a link 
but as plain text. The active primary profile is displayed as a link with the text 
“Stop <name of profile>”. Click this link first to stop the active profile. Then 
click your new profile, which is now displayed as a link.

For information on setup of the user groups, see Managing LAN network users 
on page 99. For information on how to set up a profile, see Using profiles on 
page 124.

Note Before starting a Streaming session, make sure you have set up a 
Streaming profile for your user group in the SETTINGS > LAN > 
Network user groups page.

Note You may have difficulties establishing the fastest Streaming 
connection if you are located close to the edges of the satellite beam. 
256 kbps Streaming on SAILOR 500 FleetBroadband and 128 kbps 
Streaming on SAILOR 250 FleetBroadband normally require an 
elevation angle of more than 15 degrees.
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Start/stop Standard data on the LAN interface

By default, Standard data is always activated on the terminal. If you only want 
Standard data to be activated when you have specifically enabled it, you can 
disable automatic activation using the SETTINGS > LAN > Network user groups 
page.

When automatic activation is disabled in the LAN page, you can manually 
start/stop your Standard data profile from the Dashboard by clicking Start 
<name of profile> or Stop <name of profile> under PROFILES ON LAN at the 
bottom of the page.

If a primary profile is already active, your new profile will not appear as a link 
but as plain text. The active primary profile is displayed as a link with the text 
“Stop <name of profile>”. Click this link first to stop the active profile. Then 
click your new profile, which is now displayed as a link.

Note If another primary profile is active you must stop it before you can 
start your new profile.
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Viewing information on calls and data sessions

The following sections in the Dashboard show information on calls and data 
sessions.

• ONGOING CALLS is a list of calls that are currently active. The list shows the 
call type and the time connected for each call.

• ONGOING DATA SESSIONS is a list of data profiles that are currently active, 
including the IP address that is assigned to each profile.

• SESSIONS TOTAL lists the totals for each connection. The list shows the 
time connected for voice and Streaming data, and MB transferred for 
Standard data.

The counters show totals for connections since the counters were last cleared.
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Using the phone book

General usage

Overview

In the phone book you can:

• Look up phone numbers.

• Look up short dial numbers for easy dialing from a handset. 

• Modify or delete existing names and phone numbers, or enter new names 
and phone numbers.
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Accessing the phone book

To access the phone book, select PHONE BOOK from the left navigation pane. 

The phone book shows all entries with entry number, name and phone 
number. Empty place holders are also included.

To sort the phone book, click the title of the column you wish to sort by. For 
example, to sort by the names in the phone book alphabetically, click on Name 
in the top row of the phone book.

The phone book holds 199 entries divided into subpages. To select the 
subpages you want, click the relevant link at the bottom of the page.
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Short dial

The entry number in the phone book is the Short dial number. When making a 
call from the terminal you can use this number instead of dialing the entire 
phone number.

Simply dial 00 <short dial> followed by # or off-hook key.

Example: To call the third entry in the phone book from an analog phone, 
take the phone off hook and dial 003 #.
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Editing phone book entries

Adding a new entry

To add a new entry, do as follows:

1. In the phone book, locate the empty entry number where you want to add 
the new phone number and click New.

2. Type in the name and phone number of the new entry and click Save 
entry.
The new name and number are now listed at the specified entry number in 
the phone book.

Modifying an entry in the phone book

To modify an entry, do as follows:

1. In the phone book, click Edit next to the entry you want to modify.

2. Modify the name or number as wanted and click Save entry.
The name and/or number in the selected entry is now replaced with the 
new information.

Deleting an entry in the phone book

To delete an entry, click Delete next to the entry you want to delete.

Deleting all entries in the phone book

To delete all the entries in the phone book, click Delete all entries in phone 
book at the bottom of the PHONE BOOK page.
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Viewing and editing the mobile numbers

To view the mobile numbers

To view the mobile numbers of the terminal, select PHONE BOOK > Mobile 
numbers from the left navigation pane. The mobile numbers are the phone 
numbers to use when making a call to the terminal.

To enter or edit the mobile numbers

To enter or edit the mobile numbers, click Edit at the bottom of the page, type 
in the numbers received from your Airtime Provider and click OK.

Note These numbers are not listed at delivery. The user must enter the 
numbers received from the Airtime Provider.
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Using the Call log

Information on total usage

To enter the CALLS page select CALLS from the left navigation pane. The CALLS 
page contains information on usage for circuit switched connections.

For an explanation of the circuit switched services, see Circuit switched 
(dialed) service on page 15.

The listed information includes:

• Time connected using Standard Voice and 

• time connected using 3.1 kHz Audio.
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Exporting the call log

The system logs all calls and data sessions. For information on how to view the 
lists of calls and data sessions, see the next section. 

To export the entire call log to a file, do as follows:

1. In the CALLS page, click the link Export call log to file.

2. Browse to the location where you want to save the log.

3. Click OK.
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Viewing the lists of calls

To see information on outgoing, received or missed calls or data sessions, 
select one of the following lists from the left navigation pane in the CALLS 
page:

• Outgoing calls shows the start time, receiving end phone number, 
duration, type (Standard or 3.1 kHz Audio) and estimated charge of each 
outgoing call. 

• Received calls shows the start time, calling phone number, duration and 
type (Standard or 3.1 kHz Audio) of each incoming call.

• Missed calls shows the start time, calling phone number and type 
(Standard or 3.1 kHz Audio) of each incoming call that was not received.

• Standard data sessions shows the start time, bytes in, bytes out and 
estimated charge of each Standard data session.

• Streaming data sessions shows the start time, duration, type (Streaming 
32, 64, 128 or 256 kbps) and estimated charge of each Streaming data 
session.

Date and time is UTC time, received from the satellite. 

For information on the available types of service, see The BGAN services on 
page 14.

You can sort each of the lists by clicking the title of the column you wish to sort 
by. 

If a list covers more than one page, you can click the relevant link at the 
bottom of the page, to go to another page.

When there are more than 100 calls in the total list, the oldest calls are 
automatically removed to make room for new calls.

Note The estimated charge is based on your entries under 
ADMINISTRATION > Call charges. Thrane & Thrane does not take 
responsibility for the correctness of this estimated charge.
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Handling messages

Sending an SMS message

To send an SMS message from the terminal, do as follows:

1. Click MESSAGES from the left navigation pane.
This page contains new incoming messages.

2. In the left navigation pane, click Write message.

Important If the terminal is not online when you attempt to send a 
message, the message is moved to the Outbox in stead of the 
Sent folder. Messages in the Outbox are not automatically sent 
when the terminal goes online. For further information on the 
Outbox, see the next section, Options for messages in the 
Outbox.

To make sure a message has been sent, check that it has been 
moved to the Sent folder.
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3. Type in the message in the Write new message field.
If the message text is too long for one SMS, the message is sent as two or 
more SMS messages. The field below the message field shows the number 
of SMS messages used to send the message.

4. Type in the phone number in the Recipient field. 
Remember 00 and country code (e.g. 00 45 to call Denmark or 00 1 to call 
USA).

5. Select whether or not you want Delivery notification for this SMS message. 
If you click Yes, the Status column in the Sent folder will show the status of 
your message when it has been sent.
You can set up delivery notification generally for all SMS messages. This 
setting is used by default when you send a message. For further 
information, see Configuring message settings on page 78.

6. Click Send.
The message is now sent and moved to the Sent folder. 

Options for messages in the Outbox

Messages in the Outbox are messages that have not been sent, e.g. because 
the terminal was not online when you attempted to send the messages.

To access the Outbox, click MESSAGES > Outbox from the navigation pane.

You have the following options for messages in the Outbox:

• When the terminal is online, click Resend next to the message you want to 
send. When the Write message page opens, click Send.
The terminal now attempts to send the message again. To make sure the 
message has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all messages in Outbox to delete all the messages.

Note The original message remains in the Outbox. When you have 
succeeded in sending the message you may want to delete it 
from the Outbox.
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Options for messages in the Sent folder

The Sent folder contains SMS messages that have been sent.

To access the Sent folder, select MESSAGES > Sent from the navigation pane. 

The Status column shows the status of each message, if you have selected 
Delivery notification when sending the message.

From the Sent folder you have the following options:

• Click Resend next to a message you want to send again. 
When the Write message page opens, click Send.
The terminal now attempts to send the message again. To make sure the 
message has been sent, look in the Sent folder. There should now be two 
copies of the sent message.

• Click Forward next to a message you want to forward. 
Type in the phone number of the new recipient and click Send.
The terminal now attempts to send the message to the new recipient. To 
make sure the message has been sent, look in the Sent folder.

• Click Delete next to a message to delete it.

• Click Delete all sent messages to delete all the messages.

Sending an SMS message to the terminal

You can send an SMS message to the terminal e.g. from a mobile phone, 
using one of the mobile numbers for voice. Dial

+ <Mobile number>

The first part of the mobile number is always 870, which is the “country code” 
for the BGAN system. If the mobile numbers are listed in the web interface, 
you can look them up as follows: 

Select PHONE BOOK > Mobile numbers. If the mobile numbers are not listed in 
the web interface, refer to your airtime subscription.

Note There are two Voice numbers, one for 3.1 kHz Audio and one for 
Standard Voice.
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Receiving a message

If a message has arrived, the icon bar at the top of the web interface shows an 
unopened envelope. Click the envelope to see the new message(s).

Otherwise, to see new messages click MESSAGES from the left navigation 
pane. 

The page shows new incoming messages. 

If the message is not an SMS message but information of voice mail, call your 
voice mail service number to hear the voice mail.
To find your voice mail number, select MESSAGES > Message settings from the 
left navigation pane and locate the Voice mail number. 

Note that the voice mail number is only shown if it is available on the SIM 
card. Otherwise, refer to the information included with your Airtime 
subscription.

Note The terminal does not accept more than 100 incoming messages 
(including read and unread messages). If you have received 100 
messages, you have to delete some of them in order to free space 
for new messages. Otherwise, the new messages are rejected.
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Options for new SMS messages

To see new messages, click MESSAGES from the left navigation pane. 

Besides viewing the new messages, you have a number of options for what to 
do with each message:

• Click Read to move it to your Inbox containing read messages.

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see 
Setting up the default message options on page 78.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• If you want to move all the new messages, click Move all new messages to 
Inbox.

Options for SMS messages in the Inbox

The messages in the Inbox are the incoming messages that have been read 
and moved from the list of new messages (refer to the previous section).

From the Inbox, you have the following options:

• Click Reply to reply to a message. 
Then type in your reply and click Send.
For information on how to include the original message in your reply, see 
Setting up the default message options on page 78.

• Click Forward to forward a message to someone. 
Then type in the phone number in the Recipient field and click Send.

• Click Delete to delete the message. 

• Click Delete all messages in Inbox to delete all read messages in the Inbox. 

Note New messages cannot be deleted until they have been moved to 
the Inbox.
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Configuring message settings

Setting up the default message options

You can set up general options for your outgoing messages. These settings 
apply by default to all your outgoing messages. Note, however, that you can 
change the Delivery notification setting for an individual message. For further 
information, see Sending an SMS message on page 73.

Do as follows:

1. Select MESSAGES > Message settings from the left navigation pane.

2. If you want to include the original message when you reply, select Yes 
next to Include message in reply.

3. Select whether or not you want Delivery notification for SMS messages. 
If you click Yes, the Status column in the Sent folder will show the status of 
your message when it has been sent.

4. Click Apply.
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Viewing or changing SMS service center number

The SMS service center number identifies the SMS service center used when 
sending and receiving SMS messages. The SMS service center number is 
stored on the SIM card.

• To see the SMS service center number, select 
MESSAGES > Message settings from the left navigation pane.

• To change the number, click Edit next to SMS service center, change the 
number and click Save. Then click Apply to apply all changes in the page.

The SMS service center number is provided from your Airtime Provider.

Viewing the Voice mail number

The Voice mail number is the number you call to hear your incoming voice 
mails.

To see the Voice mail number, select
MESSAGES > Message settings from the left navigation pane.

Note The Voice mail number is only listed if it is available on the SIM 
card. Otherwise, refer to the information included with your Airtime 
subscription.
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Setting up the interfaces

The SETTINGS page (Antenna properties)

The SETTINGS page shows properties of the connected antenna and contains a 
field for enabling or disabling the L-Band interface on the terminal.

To access the SETTINGS page, select SETTINGS from the left navigation pane.

Enabling or disabling the L-Band interface

The L-Band interface is used for connecting a broadband receiver for 
reception of position data. To enable or disable the L-Band interface, do as 
follows:

1. In the L-BAND CONNECTOR field of the SETTINGS page, select Enable or 
Disable.

2. Click Apply.
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Configuring the LAN interface

Overview

The SAILOR FleetBroadband terminal has 4 LAN connectors with PoE (Power 
over Ethernet). 

The major part of the LAN parameters are set up in the network management 
pages, which are protected by Administrator password. For information on 
these settings, refer to Managing LAN network users on page 99.

Caution! All connections to the LAN interface may be affected when 
you change the settings below. This also includes your own 
current connection.
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Setting up the LAN interface

Do as follows:

1. From the left navigation pane, select SETTINGS > LAN.

2. At DHCP status, select Enabled (recommended), or Disabled.

• If you select Enabled, the terminal assigns dynamic IP addresses to 
devices connected to the terminal. 

• If you select Disabled, you need to set up a static IP address in the 
connected device.

3. Type in the Local IP address and the Netmask.
The Local IP address is the IP address used for accessing the web 
interface.

4. Click Apply.
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Port forwarding

Port forwarding enables you to setup a server connected to the terminal while 
the terminal is in Shared mode. Without port forwarding it would not be 
possible to contact the server from the internet.

For information on how to set the terminal in Shared mode, see Setting up the 
network user groups on page 100.

The following example shows how to allow internet access to a mail server 
(smtp) connected to the terminal. 

The mail server in this example has the IP address 192.168.0.100.

1. Select LAN > Port forwarding in the left navigation pane.

2. Select Enabled to generally enable port forwarding.

3. Type in the port number of the Incoming port.

4. Type in the Destination IP address, which in this example is the IP address 
of the mail server: 192.168.0.100.
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5. Type in the Destination port number. 

6. Repeat step 3 to step 5 to set up port forwarding to additional servers.

7. In the Active column, select which ports should have port forwarding 
activated.

8. Click Apply.

You can now access the mail server from the Internet, using the external IP 
address of the terminal.
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Configuring the Phone/Fax interface

Do as follows:

1. Select SETTINGS > Phone/Fax from the left navigation pane.

2. For each Phone/Fax port, set the call type for incoming and outgoing calls. 

The call types are described in more detail in Selecting the call type on 
page 35.

• For Incoming calls, you can check Standard or 3.1 kHz Audio or both. 
If you check both, any device connected to the Phone/Fax interface will 
react (ring) on incoming calls. 
If you select e.g. Standard, the Phone/Fax interface will only react on 
calls made to the Standard phone number.

Note Port 1 is the connector closest to the antenna connector, and Port 
2 is the connector closest to the ISDN connector.
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• For Outgoing calls, you can select either Standard or 3.1 kHz Audio. 
The selected type will be used by default, if possible, for any outgoing 
call. Note, however, that fax machines and modems must use 3.1 kHz 
Audio.

3. Click Apply.

Note You can override the default setting for outgoing calls by dialing 
1* (force the call to Standard) or 2* (force the call to 3.1 kHz 
Audio) before the number. For further information, see 
Overriding the default outgoing call type on page 36.
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Configuring the ISDN interface

To configure the ISDN interface, do as follows:

1. Select SETTINGS > ISDN.

2. Set the call type(s) for incoming calls.
You can select Standard, 3.1 kHz Audio, UDI and/or RDI. Note that for 
SAILOR 250 FleetBroadband you can only select Standard or 3.1 kHz Audio.

Note For information on how to set up call services (supplementary 
services), see Setting up call services on page 92. These settings 
apply to both the Phone/Fax interface, the ISDN interface and the 
LAN w. PoE interface.

Note Connected devices will only receive incoming calls with the call 
types that are selected here. 
For example, if only Standard is selected, and a G4 fax call 
(using call type UDI) arrives, a fax connected to the ISDN port 
will not receive the incoming call. 
Setting up the interfaces 87



Chapter 4:  Using the web interface
3. Set the MSN numbers that are to be assigned to each call type. 
Note that this setting only applies to the call type selected above the MSN 
number, and only if the connected device supports the call type used.

You have the following options with the MSN numbers:

• <None>. No MSN numbers are used. An incoming call is accepted in all 
devices connected to this port.

• 1*, 2*, 3* or 4*: If, for example, you select 1* at Standard call type, an 
incoming Standard call is accepted by all devices that are programmed 
with the number 1* and connected to the ISDN interface.

• 0401, 0402: These are local numbers for separate devices connected to 
the ISDN interface.
An incoming call is accepted by devices that are programmed with the 
selected number and connected to the ISDN interface. 

You can combine the MSN settings.

Example: You have two devices connected to the ISDN interface. One is 
programmed with the numbers 1* and 0401, the other is 
programmed with 1* and 0402. 
In the web interface, you select the MSN number 1* under 
Standard.
If an incoming Standard call arrives, both devices will accept 
the call. 
If you make a local call to one of the local numbers 0401 or 
0402, only the called device will accept the call.

4. Set the call type for outgoing calls.

• If you select Automatic, the call type will be determined by the calling 
device.

• If you select Standard, all outgoing calls, except UDI/RDI, will use the 
call type Standard. If you make a 3.1 kHz Audio call it will be converted 
to a Standard call.
Outgoing UDI or RDI sessions will be not be influenced by this setting.

Important If you set an MSN number to anything other than <None>, 
connected devices must be programmed with these MSN 
numbers.
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• If you select 3.1 kHz Audio, all outgoing calls, except UDI/RDI, will use 
the call type 3.1 kHz Audio. If you make a Standard call it will be 
converted to a 3.1 kHz Audio call. Outgoing UDI or RDI sessions will be 
not be influenced by this setting.

5. Click Apply.

Note You can override the call type setting for outgoing calls by 
dialing one of the following prefixes before the number:

• 1* (force the call to Standard)

• 2* (force the call to 3.1 kHz Audio)

Refer to Overriding the default outgoing call type on page 36.
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Setting the common interface settings

The common APN

The common APN setting is defined here and can be selected for each network 
user group. If you are using the same APN for many user groups, it is easier to 
define it once, and then simply select it for the relevant user groups. Also, if 
you change the common APN at a later stage, it is automatically updated for 
all user groups where the Common setting is selected.

To set up the common interface settings

Do as follows:

1. Select SETTINGS > Common.
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2. Select the APN. You have the following options:

• SIM default. The APN is taken from the SIM card. This is the 
recommended option, unless you have special requirements.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime 
Provider.

3. At Buffering on Streaming profiles, select Enabled or Disabled.

• If you select Enabled, your Streaming connection will be buffered. This 
means that the transmission is slightly delayed in order to ensure a 
precise and continuous data stream.

• If you select Disabled, your Streaming connection will not be buffered. 
This means the data is delivered immediately, but may vary slightly in 
transmission speed.

4. Click Apply.

How to use the common APN

When you configure the APN for your individual network user group, select 
Common to use the setting from this page. 

Where Common is selected in the individual groups, the setting will 
automatically be updated when the Common APN is changed.
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Setting up call services

Overview

In the web interface you can set up the following supplementary services:

• Call forwarding

• Call barring

• Call waiting

• Line identification

• Closed user group

Note that, depending on the network, some of these call service settings may 
prevent others from being activated.

The settings apply for all connected devices using a circuit-switched service.

Note The terminal must be registered on the BGAN network before you 
can set up the call services in the web interface.
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Call forwarding

You can set up the terminal to automatically forward incoming calls to another 
phone number. Do as follows:

1. Select SETTINGS > Common > Call forward from the left navigation pane.

2. For each call type, select Enabled next to the situation(s) in which you 
want to forward incoming calls.

3. Next to the enabled items, type in the phone number you want to forward 
the call to.

4. If you have selected Forward if no reply, select from the drop-down list the 
period of time the system should wait before forwarding the call.

5. Click Apply.
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Call barring

Do as follows to bar incoming and/or outgoing calls to and from the terminal:

1. Select SETTINGS > Common > Call barring from the left navigation pane.

2. Click OK next to Read current settings, to make sure the page is updated.

3. For each call type, select which calls should be barred.

4. In the Barring PIN field, type in a PIN for your call barring setup.

5. Click Apply.

Note This is not the SIM PIN entered at startup, but a network PIN 
which is supplied together with your SIM PIN. 
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Call waiting

You can set up whether or not you want to receive notification of waiting calls 
while you are making a call or transmitting data.

Do as follows:

1. Select SETTINGS > Common > Call waiting from the left navigation pane.

2. Click OK next to Read current settings to make sure the page is updated.

3. For each call type, select Call waiting enabled if you want to get 
notification of waiting calls while you are making a call or transmitting 
data.

4. Click Apply.
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Line identification

You can set up the terminal to show your number when you are making a call 
or transmitting data.

Do as follows:

1. Select SETTINGS > Common > Line identification from the left navigation 
pane.

2. Select Show my number and click Apply.
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Closed user group

Your subscription may include one or more closed user groups. A closed user 
group is a group of users permitted to make calls to each other but not to 
users outside the group.

To define the settings for these user groups, do as follows:

1. Select SETTINGS > Common > Closed user group from the left navigation 
pane.

2. Type in your user group number(s) under Group no.

3. Select which group(s) should be active.
If you select Subscribed, the group(s) included in your subscription will be 
active.
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4. To allow outgoing access for the activated user group(s), select Outgoing 
Access under SETTINGS FOR ACTIVE CLOSED USER GROUP. Note that if you 
selected Subscribed above, this setting will not be used.

5. Select Preferential if you want the activated user group to be selected 
when a member of a user group does not specify the group number during 
call set up. Note that if you selected Subscribed above, this setting will not 
be used.

6. Click Apply.
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Managing LAN network users

Overview

Network user groups and profiles

The LAN users of the SAILOR FleetBroadband system can be organized in 
network user groups with different setup and different access rights.

The steps necessary for managing network users include:

1. Defining a network user group. See Setting up the network user groups on 
page 100.

2. Identifying a network device. See Managing network devices on page 104.

3. Associating the network user group and the network device. See The 
Network classification table on page 106.

Access to the network management settings

Access to the network management settings requires an Administrator 
password.

The Administrator can create and manage network user groups and set up a 
Network Classification table defining priorities for devices, network groups 
and LAN ports.

Caution! All user connections to the LAN interface may be affected 
when you change the settings below, including your own 
current connection.
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Setting up the network user groups

Overview

A network user group, in this context, is a group of network users sharing the 
same Quality of Service profile and network parameters.

There are 11 configurable network user groups. For the Default user group, 
certain settings are locked, to make sure there is always one functional user 
group available. For example, the Default user group does not allow you to 
select a direct connection.

The network user groups cannot be deleted. If you do not want to use them, 
click Edit and select Disabled at Status in the NETWORK USER GROUP field.

Editing a network user group

Do as follows:

1. Select SETTINGS > Network user groups.
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2. Click Edit next to the user group you want to set up.

3. Type in a name for the group.

4. Select Enabled or Disabled.

5. Select the type of Internet connection.

• Shared means the connection will be shared with other users, and the 
NAT module of the terminal will make the necessary address 
translations. Use this mode if one or more computers are connected 
using the LAN interface, and the terminal should act as a router. 

• Direct is an exclusive connection, with NAT disabled. Use this mode 
together with a network classification entry that selects a single 
computer. This mode is not available in the Default user group.

Note For further explanation of the below settings, see Definitions for 
network terms on page 109.
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• No internet access means no connection to the Internet is allowed. Use 
this setting e.g. for IP handsets, where an Internet connection is not 
required. The external voice connection is still available; this setting 
only affects communication over the Internet.

6. Select Dynamic IP address. 
This is the IP address used externally on the satellite network.
If you want to use a static IP address, and your subscription allows for it, 
leave this setting at Dynamic. Then select SIM default in step 8 and type in 
the APN user name and password from your provider in step 9. 
Your terminal will then use the static IP address set up for your SIM card.

7. Set IP Header compression to Enabled or Disabled. 
For information on IP Header compression, see Header compression on 
page 109.

8. Select the source of the APN (Access Point Name).
There are four options for setting the APN. Unless you have special 
requirements, it is recommended to use the SIM default, or to set the 
common APN to SIM default, and then select Common here. You have the 
following options:

• Common. The APN is taken from the Common APN defined under 
SETTINGS > Common. Refer to Setting the common interface settings 
on page 90.

• SIM default. The APN is taken from the SIM card. If you want to use a 
static IP address on the external network, select this option either here 
or in the Common setting.

• Network assigned. The APN is assigned from the network.

• User defined. Type in the APN. APNs are provided from the Airtime 
Provider.

9. If your APN uses a password, type in the user name and password 
provided from the Airtime Provider. 

Note Typing in a static IP address is currently not supported by the 
BGAN network.

Note If you are going to use the static IP address from your SIM card, 
the user name and password are mandatory! See step 6 above.
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10.  At Automatic activation select whether the profile should be activated 
automatically or manually.

• Disabled means you can activate/deactivate the profile from the 
Dashboard.

• Enabled means the profile is activated automatically.

11. Select the Primary profile.
Select a profile from the Primary scroll list. This profile is used by this 
network user group as a first choice, when possible. 
There are 5 predefined profiles (4 in the SAILOR 250 FleetBroadband): 
Standard, Streaming 32 kbps, Streaming 64 kbps, Streaming 128 kbps and 
Streaming 256 kbps (only SAILOR 500 FleetBroadband). Additionally, you 
can define your own custom profiles.

For further information on profiles and traffic flow filters, see Using 
profiles on page 124 and Using traffic flow filters on page 128.

12. Select the Secondary profile.
To select more than one secondary profile, press and hold Ctrl or Shift 
while selecting.

The Context Identifiers (CIDs) for the selected primary and secondary 
profiles are listed under Profile CIDs.

13. Click Apply.

Note If the selected primary profile is a Streaming profile, this setting 
has no effect. Streaming profiles must always be activated 
manually from the Dashboard.

Important If you have selected a Streaming connection as your 
primary profile, the LAN interface will be running a 
Streaming connection until you stop it or disconnect the 
interface. However, if you select one or more secondary 
profiles, you can set up your traffic flow filter so that it will 
only use the Streaming profile for certain types of traffic.

Note If you have selected both a primary and one or more secondary 
profiles you must define a traffic flow filter before you can 
establish a valid connection.
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Managing network devices

Overview

A network device, in this context, is an Ethernet hardware device, identified by 
a unique MAC address.

When a network device with dynamic IP address is connected to the terminal, 
it is automatically listed in the Network devices list.

Viewing the list of network devices

To view the list of network devices, select SETTINGS > Network devices.
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For each device, the list shows:

• IP address

• MAC address

• Device name (if available)

Locking an IP address to a MAC address

When the device is locked to an IP address, the terminal will always assign 
this IP address to the MAC address of this device (if DHCP is enabled and the 
Internet connection is not a Direct connection).

To lock a device to its current IP address, click the link next to the device. 
The device is then locked to the current IP address and added to the list of 
locked IP addresses at the top of the page.

To unlock a device from the IP address, click Delete next to the device in the 
LOCKED IP ADDRESSES list.
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The Network classification table

Overview

The Network classification table is used for making an association between 
network devices and network user groups.

Each entry in the table shows MAC address, IP address, LAN port and Network 
user group.

The Network classification table is prioritized, meaning that the entries are 
evaluated in the order they are listed.

Adding or editing an entry in the Network classification table

To add a new entry to the table or to edit an existing entry, do as follows:

1. Select SETTINGS > Network classification table.

The classification table shows which devices are associated with which 
LAN ports and user groups. An Asterisk (*) is a “wild card”, meaning that 
any value is accepted.
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2. Click Edit next to the entry you want to edit, or click Add at the bottom of 
the list.

3. Click Add next to a network device you want to use, or type in the MAC 
address manually at the top of the page.

4. Select the LAN port and Network user group you want to associate with 
the device.
User groups are created and defined in the Network user group page. See 
Setting up the network user groups on page 100.

5. Click Apply.
Your changes now appear in the Network classification table.

Note If you leave a field empty, it is the same as a “wild card” and it 
will be shown as an Asterisk in the Network classification table.

Unless you are using a Static IP address, the IP address field 
should always be left empty.
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Removing an entry in the Network classification table

In the Network classification table, click Delete next to the entry you want to 
delete.

Changing the priority in the Network classification table

The Default user group is always last.

To change the priority of an entry, click the up or down arrow next to the entry.
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Definitions for network terms

APN (Access Point Name)

The APN is used by the network user to establish the connection to the 
required destination network. This means that the terminal must know the 
APN in order to be able to connect to the destination network. 
APNs are provided from the Airtime Provider. They may also be defined on the 
SIM card.

Header compression

The Header of a data packet contains control information belonging to that 
packet. The information in the Header can take up a considerable amount of 
bandwidth. In order to save bandwidth, you can use Header Compression, 
meaning you compress the header information, leaving some of the 
information out.

You can select whether or not to use Header Compression for your data 
transmission.

• Header Compression enabled: Recommended for low-noise applications.
If you select Header Compression enabled, you will be using less 
bandwidth on header information, leaving more bandwidth for the actual 
payload. 
However, if the environment is noisy, the system will have to retransmit 
information, and you may end up using more bandwidth than without 
Header Compression.

• Header Compression disabled: Recommended in noisy environments.
If Header Compression is disabled, the system will be less sensitive to 
noise.

Profiles

A profile is a collection of Quality of Service (QoS) settings and other settings 
defining the mode in which data is transmitted on an interface. For example, a 
profile is used to define whether a connection should be a Standard or 
Streaming connection.
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You can select between a number of predefined profiles or define your own 
profiles for your data transmission.

You need an Administrator password to define profiles and traffic flow filters.

NAT (Network Address Translation)

NAT enables a local-area network to use one set of private IP addresses for 
internal traffic and an assigned or static IP address for external traffic. The 
built-in NAT module in the terminal makes all necessary address translations 
between the local-area traffic and the external traffic.
If more than one user is connected, you must select a network user group with 
Shared mode to use the NAT of the terminal. 

Note If you have selected more than one profile (one primary and one or 
more secondary profiles) for an interface, you must define a traffic 
flow filter before you can establish a valid connection.
110 Managing LAN network users



Chapter 4:  Using the web interface4

U
si

ng
 th

e 
w

eb
 in

te
rfa

ce
4
4

4

Software upload and event log

Uploading software

Introduction

You can upload software from your computer to the terminal without entering 
the PIN. However, if your SIM card requires a PIN and the PIN is not entered, 
you must enter the Administration user name and password.

The web interface also offers the possibility of downloading the latest software 
version from the Internet to your computer.

Uploading software from your computer

To upload software from your computer to the terminal, do as follows:

1. Download the new software as described in the next section, or acquire 
the software from Thrane & Thrane and save it on your computer.

2. Open the web interface and do one of the following:

• If the PIN has been accepted (or a PIN is not required), select 
SETTINGS > Upload from the left navigation pane.

• If a PIN is required and the PIN has not been entered, select 
ADMINISTRATION, enter the Administration PIN and password and 
click Logon. 
The default user name is admin and the default password is 1234. 
Then select Upload from the left navigation pane.
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The SOFTWARE UPLOAD page opens.

3. In the field UPLOAD SOFTWARE TO TERMINAL, click Browse...

4. Browse to the new software version and accept it.

5. Click the Upload button.

6. Note that the upload procedure takes a couple of minutes.

Note When upload is done, your terminal automatically restarts with 
the new software.
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Downloading software from the Internet

To download the latest software from the Internet to the terminal, do as 
follows:

1. Make sure you have a connection to the Internet from your terminal.

2. Open the web interface and select SETTINGS > Upload from the left 
navigation pane.

3. Click Check for updates.
The terminal will now connect to the Internet through the BGAN network, 
using your airtime subscription. It may take a minute or two to obtain the 
new software version.

Important The terminal uses your BGAN airtime subscription to 
download the new software from the Internet. Note that it 
can take several minutes to download the software.
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When the new software version is found, the web interface shows the new 
software version and a link for downloading the software to your 
computer.

4. Click the link to download the new software to your computer.
After saving the software on your computer, follow the procedure in the 
previous section (Uploading software from your computer) to upload the 
software from the computer to your terminal.

Viewing the Event list or the Event log

Overview

When an event is registered, the web interface shows an event icon in 
the icon bar as long as the event is active.

The Event list only shows events that are currently active, whereas the Event 
log shows the last 100 events that have occurred.
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Event list

To view the event list, click the event icon from the icon bar at the top of the 
web interface, or select HELPDESK > Event list from the left navigation pane.

The Event list page shows a detailed list of active events including the time of 
the first occurrence, ID and severity of the event message, and a short text 
describing the error. For more information on the event messages, refer to 
Event messages on page 150.

Event log

To view the Event log, select HELPDESK > Event log from the left navigation 
pane.

The Event log shows the same information as the Event list, but also includes 
events that occurred in the past and are no longer active.
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Selecting the preferred BGAN satellite

Overview

By default the terminal is set up to automatically find the most appropriate 
satellite to connect to (“Auto” mode). However, if you are located in an area 
with more than one BGAN satellite available, you can select the satellite you 
prefer to use when connecting to the BGAN network.

To select the preferred BGAN satellite

Do as follows:

1. Select SETTINGS > Satellite selection from the left navigation pane.
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2. Select the satellite you prefer to use.
If you select Auto (the default setting) the SAILOR FleetBroadband 
system automatically uses the most appropriate satellite.
Note that at this writing the POR satellite is not yet available.

3. Click Apply.

Note If you have selected one of the satellites, your 
SAILOR FleetBroadband system will only try to establish a connection 
to the selected satellite. This means that if the antenna is outside the 
coverage area for that satellite, the SAILOR FleetBroadband system 
will not be able to register with the BGAN network. 
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Administration

Accessing the administration settings

Logging on

The Administration settings require an Administration user name and 
password. 

1. Select ADMINISTRATION from the left navigation pane.

2. Enter the Administration user name and password. 
The default user name is admin and the default password is 1234.

If you have forgotten the administrator password, you can reset the 
password by clicking the link at the bottom of the page. For further 
information, see the next section Resetting the Administrator password.

3. Click Logon.
The Administration page is now updated to let you change the user name 
and password, Save/load a configuration or log off Administration.
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Resetting the Administrator password

If you have forgotten the administrator password, do as follows:

1. Contact your supplier for a reset code.
Please report the serial number and IMEI number of the terminal.
You can find the serial number and IMEI number in the Dashboard.

2. Click the link Forgot administrator password? at the bottom of the 
ADMINISTRATOR LOGON page (see the previous section).

3. Type in the reset code obtained from your supplier and click Reset.

4. Type in the user name Admin and the default password 1234.

5. Click Logon.
For information on how to change the password, see the next section 
Changing the administrator password.
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Changing the administrator password

Do as follows:

1. After entering the Administrator user name and password in the 
ADMINISTRATION page, locate the section Change administrator logon.

2. Type in the existing user name.

3. Type in the new password and retype it on the next line.

4. Click Change.
At the next logon the new password is required.
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Saving a configuration to a file

If you need to reuse a configuration in another terminal of the same type, you 
can save your current configuration to a file, which can then be loaded into 
the other terminal.

Do as follows:

1. In the ADMINISTRATION page, under Configuration, click Save.

2. Accept the default destination file name or type in the destination file 
name and location.

3. Click OK.
The configuration is now saved to a file. This file is used to load the 
configuration into another terminal. See the next section.

Loading a configuration from a file

1. In the ADMINISTRATION page, under Configuration, click Load.

2. Click Browse... to browse to the file you want to import. Then click Open.

3. Click Load.
The new configuration is now loaded into your terminal.

Logging off administration

If you have not entered anything for 30 minutes under ADMINISTRATION, you 
are logged off automatically.

To log off manually, click Logoff under Administrator logoff in the 
ADMINISTRATION page.
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Call charges

If you know the tariff for your subscribed services, you can enter these tariffs in 
the web interface and automatically calculate the charges for your calls and 
data sessions.

Do as follows:

1. From the left navigation pane, select 
ADMINISTRATION > Call Charges

2. Select the currency from the Currency drop-down list.

3. Enter the tariff for each of the services.

Note Thrane & Thrane does not take responsibility for the correctness of 
the estimated charges. This calculation is only a rough estimate of 
the charge, based on the tariff entered by the user. Also, the Airtime 
Provider may have different methods of calculating the charge.
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4. Click Apply.
The entered tariffs are used for estimating the charges for calls and data 
sessions. The estimated charge is listed for each call or data session in the 
call log. For further information, see Viewing the lists of calls on page 72.

Log handling

1. From the left navigation pane in the ADMINISTRATION page, select Log 
Handling.

2. To clear the Call log, click OK next to Clear call log?. 

3. To clear the total counters, click OK next to Clear total counters?.
This will reset the Time connected counters on the Calls page.
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Using profiles

What is a profile?

A profile is a collection of Quality of Service (QoS) settings and other settings 
defining the mode in which data is transmitted. For example, a profile is used 
to define whether the connection is a Streaming connection or a Standard 
connection.

You can select between a number of predefined profiles or define your own 
profiles for your data transmission.

If no traffic flow filters are defined, the Primary profile for a user group is used 
for all traffic from that user group. See What are traffic flow filters? in the next 
section. 

For further information on profiles, refer to the 3GPP standard TS 23.107.

Selecting the profiles for a network user group

When you set up a network user group, you select the profiles to use for that 
user group. You select a Primary profile and optionally one or more Secondary 
profiles.

For further information on how to select the profiles, see Managing LAN 
network users on page 99.
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Defining new profiles

When you define your profiles you can select Subscribed for many of the 
settings. If you select Subscribed, the value given in your Airtime subscription 
will automatically be used.

To define a new profile, do as follows:

1. From the left navigation pane, select ADMINISTRATION > Profiles.

2. In one of the User defined columns, fill in the top field with the name of 
your profile.

Note For SAILOR 250 FleetBroadband, the maximum Streaming bit rate is 
128 kbps.
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3. In the Traffic class row of your new profile, select a class from the drop-
down list.

You may select one of the following:

• Conversational is real-time two-way conversation. It is primarily used 
for voice over IP and video conferencing.

• Streaming is real-time one-way communication. It is primarily used for 
video and audio.

• Interactive is two-way communication (not real-time). It is used for 
communication that is not very delay-sensitive, such as web browsing, 
data base retrieval and server access. Examples of machines 
interaction with remote equipment are: polling for measurement 
records and automatic data base enquiries (tele-machines).

• Background is used for data which is not delay-sensitive, such as E-
mails, SMS, download of databases and reception of measurement 
records.

4. Type in the bit rates in kbps in the following rows:

• Maximum bit rate ul (kbps) is the maximum upload bit rate allowed for 
this profile.

• Maximum bit rate dl (kbps) is the maximum download bit rate allowed 
for this profile.

• Guaranteed bit rate ul (kbps) is the guaranteed upload bit rate needed 
for this profile.

• Guaranteed bit rate dl (kbps) is the guaranteed download bit rate 
needed for this profile.

Important For best performance, choose the right traffic class for your 
application. In general, Standard data (Background) is best 
suited for TCP/IP applications, and Streaming data is best 
suited for UDP traffic, e.g. live video or audio.

Note For SAILOR 250 FleetBroadband the maximum allowed bit rate is 
128 kbps.

Note When you click Apply, the bit rate values you typed in may be 
rounded off because only certain values are allowed.
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5. In the Delivery order row, select from the scroll list whether or not data 
should be delivered in the same order it was sent. Yes means the data 
packets are delivered in the same order they were sent.

6. In the Maximum SDU size (byte) row, type in the maximum allowed packet 
size in Bytes (rounded off to nearest 10). The maximum packet size 
possible is 1520.

7. In the Delivery of erroneous SDUs row, select one of the following from the 
list:

• Yes means packets are allowed to contain errors. This setting is 
suitable for delay-sensitive transmission, because the need for 
retransmission is limited. The SDU Error settings in step 8 and step 9 
will apply.

• No means packets are not allowed to contain errors, and the SDU Error 
setting in step 8 will not be applied. This setting is suitable where 
error-free transmission is important and delays are accepted.

• No detect means that errors will not be detected, and the SDU Error 
setting in step 8 will not be applied.

8. If you selected Yes in step 7, select from the SDU error ratio drop-down list 
the fraction of a packet allowed to be lost or erroneous.

9. Select from the Residual bit error ratio drop-down list the undetected bit 
error ratio of a packet. If no error detection is requested, Residual bit error 
ratio indicates the bit error ratio in the delivered packets.

10. In the Transfer delay (ms) row, type in the delay in ms. This is the delay 
from the time data is received in the terminal until it arrives at the 
receiving end.

• If the Transfer delay is 500 ms, error correction is disabled.

• If the Transfer delay is 4000 ms, error correction is applied.

11. In the Traffic handling priority row, select from the drop-down list which 
priority this connection should have.

12. Click Apply.
The new profile is now added, and can be selected from the lists of primary 
and secondary profiles when you set up your interfaces.
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Using traffic flow filters

What are traffic flow filters?

Traffic flow filters allow the Core network and the terminal to classify packets 
received from the external network into the proper profile.

A list of traffic flow filters consists of one to eight packet filters, each identified 
by a unique packet filter identifier. A packet filter also has an evaluation 
precedence index that is unique within all traffic flow filters associated with 
the profiles that share the same PDP (Packet Data Protocol) address. 
Information of source, destination, type of service etc. is combined in each 
packet filter in the list.

Purpose of the traffic flow filters

The purpose of the traffic flow filters is to assign different priorities to different 
types of traffic, in order to optimize performance.

Example: When you are browsing the Internet, a Standard data connection is 
normally sufficient. However, to have a video conference you may 
need a Streaming connection in order to obtain a direct connection 
without interruptions. Your traffic flow filters can define these 
priorities, so that your connection automatically switches to 
Streaming e.g. when you have a video conference.
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Defining traffic flow filters

To define the traffic flow filters, do as follows:

1. From the left navigation pane, select 
ADMINISTRATION > Traffic flow filters.

2. Click the link New entry.
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3. Type in an Evaluation Precedence Index in the Eval.Prec. Index column.

4. Select the Profile from the scroll list.
The available profiles are the profiles listed in the ADMINISTRATION > 
Profiles page.

5. Fill in one or more of the following fields to define the filter.
The allowed ranges appear in hover text when you pass the mouse over 
the fields.

• Source address + Subnet mask.

• Protocol number.

• Destination port range (From and To). Note that Source and 
Destination are relative the core network. This means that Destination 
is your terminal.

• Source port range (From and To).

• Type of Service + Type of Service mask.

For further information on the principles and parameters of the traffic flow 
filters, refer to the 3GPP standards TS27.007 V4.2.0 and TS 23.060 V4.7.0.

6. Click Apply at the bottom of the page.

Note This field is mandatory. Each filter must have a different 
Evaluation Precedence Index. 
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Setting up user permissions

You can restrict access to parts of the web interface for non-administrator 
users.

To set up the user permissions, do as follows:

1. From the left navigation pane, select ADMINISTRATION > User 
permissions.

2. For each item under ALLOW USERS TO:, select

• yes to allow access or 

• no to block access to the settings.

3. Under ALLOW AT COMMANDS ON:, select

• yes to allow the use of AT commands on the LAN interface, or 

• no to block the use of AT commands on the LAN interface.
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Note that this setting does not take effect until the terminal is restarted.

4. Click Apply.
The settings to which access is denied are now greyed out for the non-
Administrator user.
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Help desk and diagnostic report

Accessing the Help desk

If you need help with airtime-related issues you may call the Help desk. By 
default, the Help desk is the phone number for your Airtime Provider, if it is 
available on the SIM card.

Select HELP DESK from the left navigation pane.

If the Help desk number is available on the SIM card, the number is displayed 
as a link. To change the number, click the link, change the number and click 
Apply.

If you need help with terminal- or antenna-related issues you should call your 
local distributor.
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Generating a diagnostic report

If you want to generate a diagnostic report, do as follows:

1. Click Generate report from the HELP DESK page. 
In some browsers the file may open directly in your browser. If it does, 
choose File > Save As to save the file.

2. Choose a location for the file and save it.

The diagnostic report contains relevant information for troubleshooting. 
Please enclose this file when you are reporting an error.

What’s next?

This chapter has explained how to use the web interface for setup and use of 
the system. You should now be able to set up the system, check status, read 
and send SMS messages, use the phone book and much more.

The following chapter, Troubleshooting, provides guidelines for 
troubleshooting, an overview of the different means of status signalling, and a 
list of available spare parts and accessories.
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Troubleshooting 5

In this chapter

This chapter gives guidelines for troubleshooting and provides an overview of 
the different means of status signaling, It also lists available spare parts and 
accessories.

Getting support

Overview

If this manual does not provide the remedies to solve your problem, you may 
want to contact your Airtime Provider or your local distributor.

Airtime support

If you need assistance from your Airtime Provider, please call the help desk. 
To see the help desk number, enter the web interface of your terminal and 
select HELP DESK. This help desk number is either taken from the SIM card or 
entered manually. If no number is available under HELP DESK, check your 
Airtime subscription for a contact number.

System support

If you need assistance with problems caused by the terminal or antenna, 
please call a distributor in your area. 

An updated list of certified partners and distributors is available on Thrane & 
Thrane’s web site: www.thrane.com. Select Maritime and select Distributors 
from the top menu bar.
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Uploading software

Viewing software version status

To view the version of the embedded software in the terminal, Connect a 
computer, enter the web interface and see the Software version field in the 
Dashboard.

Uploading software using the web interface

You can upload software from the web interface. 

If you have an Administrator user name and password you do not need to 
insert a SIM card nor to enter the PIN to be able to upload software.

For further information, see Uploading software on page 111.
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Spare parts, SAILOR®500 FleetBroadband

Antenna spare parts

Cables

Item Part number

HPA module S-62-124671

ATB/LNA module S-88-126533-A

GPS module S-60-124765

Item Part number

Antenna cable, 30 m 37-126525

Power cable 37-125999

LAN cable 37-203213
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Spare parts, SAILOR®250 FleetBroadband

Cables

Item Part number

Antenna cable, 25 m 37-204567-025

Power cable 37-125999

LAN cable 37-203213
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Options and accessories

The following options and accessories are available from Thrane & Thrane:

Item Part number

Basic cable support kita

a. Included in the basic package for both SAILOR 500 FleetBroadband and 
SAILOR 250 FleetBroadband.

673738A

FleetBroadband extended cable support kit 403738A-940

Thrane & Thrane IP Handset and Cradlea 403670A-00500

Thrane & Thrane IP Handset 403672A

Thrane & Thrane IP Cradle 403674A
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Troubleshooting guide

The below table provides information on some of the problems that might 
occur, including possible causes and remedies to solve the problems.

Problem Possible Cause Remedy

No signal or 
weak signal 
from the BGAN 
satellite.

The view to the 
satellite is blocked.

Make sure the antenna has a 
clear view in all directions. See 
the installation manual for 
details.

The antenna cable 
is not properly 
connected.

Check that both ends of the cable 
are connected properly according 
to the guidelines in the 
Installation manual.

Also check that no connectors are 
damaged.

The system is set 
up to use one 
specific satellite, 
but the system is 
outside coverage 
from that satellite.

Enter the web interface. Select 
SETTINGS > Satellite selection. 
Select Auto and click Apply. 

The system will now search for 
the satellite with the strongest 
signal and attempt to connect.

No 
transmission on 
the BGAN 
network is 
possible.

The Radio silence 
function is 
activated from an 
external device 
connected to the 
I/O interface of the 
terminal.

If the Radio silence function 
should not be activated, 
deactivate it from the external 
device.
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Connection to 
the Internet 
cannot be 
established.

Your network user 
group does not 
allow Internet 
access.

The Administrator can access and 
change network user groups in 
the built-in web interface of the 
terminal.

256 kbps 
Streaming does 
not work

The elevation 
angle to the 
satellite is too low.

Availability of 256 kbps Streaming 
can only be guaranteed in areas 
with over 15 degrees elevation.

128 kbps 
Streaming does 
not work on 
SAILOR 250 
FleetBroadband

The elevation 
angle to the 
satellite is too low.

Availability of 128 kbps Streaming 
on SAILOR 250 FleetBroadband 
can only be guaranteed in areas 
with over 15 degrees elevation.

The web 
interface 
cannot be 
accessed.

The browser is 
configured to use a 
proxy server.

For Microsoft Internet Explorer, 
select Tools > Internet Options > 
Connections > LAN Settings and 
uncheck Use a proxy server for 
your LAN.

You have entered a 
wrong IP address.

Check the IP address and re-enter 
it. If you do not have the correct 
IP address, you can set the IP 
address temporarily to the default 
address (192.168.0.1) by pressing 
the Reset button. See Function of 
the Reset button on page 153.

You are connected 
using VPN

Close down your VPN connection.

Problem Possible Cause Remedy
Troubleshooting guide 141



Chapter 5:  Troubleshooting
A Phone/Fax 
connection 
cannot be 
established.

The cable is not 
properly 
connected.

Connect the cable.

The cable type or 
connector type is 
not correct.

For information on the correct 
type of connector and cable, refer 
to the installation manual.

Incoming calls: 
The call type used 
for the call is not 
selected in the web 
interface.

Make sure the call type used for 
calls to the terminal is selected in 
the web interface. Access the web 
interface and select SETTINGS > 
Phone/Fax. Then, for each of the 
two ports, select the call type for 
incoming calls.

SAILOR 250
FleetBroadband: If 
you are located in 
a low elevation 
area (<20°), 
3.1 kHz Audio is 
not supported.

Use Standard voice in stead of 
3.1 kHz Audio when you are 
located in areas with low 
elevation (< 20°).

Problem Possible Cause Remedy
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An ISDN 
connection 
cannot be 
established

The cable is not 
properly 
connected.

Connect the cable.

You have 
connected to the 
LAN interface.

Connect the cable to the interface 
marked ISDN.

The cable type or 
connector type is 
not correct.

For information on the correct 
type of connector and cable, refer 
to the installation manual.

Incoming phone 
calls: The call type 
used for the call is 
not selected in the 
web interface.

Make sure the call type used for 
calls to the terminal is selected in 
the web interface. Access the web 
interface and select SETTINGS > 
ISDN. Then select the call type for 
incoming calls.

SAILOR 250
FleetBroadband: 
The ISDN service is 
not supported.

Use another service. You may still 
use the ISDN interface on the 
terminal, but only Standard voice 
and 3.1 kHz Audio are available.

No phones are 
ringing on 
incoming calls

The Mute function 
is activated from 
an external device 
connected to the 
I/O interface of the 
terminal.

If the Mute function should not be 
activated, deactivate it from the 
external device.

Problem Possible Cause Remedy
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A LAN 
connection 
cannot be 
established.

The cable is not 
properly 
connected.

Connect the cable.

The cable type or 
connector type is 
not correct.

For information on the correct 
type of connector and cable, refer 
to the installation manual.

An IP handset 
connection 
cannot be 
established.

The cable is not 
properly 
connected.

Connect the cable.

You have 
connected to the 
ISDN interface.

Remove the cable and connect to 
one of the LAN connectors in 
stead.

There is no power 
(PoE) in the LAN 
interface. The 
reason may be that 
there is not 
enough power to 
supply PoE for the 
LAN interface.

Check that the input voltage is 
within the specified range 
(10.5 - 32 V DC; 14 A - 5.5 A).

Check that you do not have too 
many power-consuming devices 
connected. The maximum 
available output power on the 
LAN (PoE) interface is 32 W if you 
are using a 12 V supply and 64 W 
if you are using a 24 V supply. 
If possible, disconnect other 
connected devices.

Problem Possible Cause Remedy
144 Troubleshooting guide



Chapter 5:  Troubleshooting

Tr
ou

bl
es

ho
ot

in
g

5
5

5
5

The 
Administrator 
password does 
not work.

Someone has 
changed the 
Administrator 
password.

If the correct password is not 
found, you have to reset the 
password. 

Contact your supplier for a reset 
code. You must provide the serial 
number and IMEI number of the 
terminal.

Then enter the web interface and 
reset the password as described 
in: Resetting the Administrator 
password on page 119.

Problem Possible Cause Remedy
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Status signaling

Overview

There are many ways of troubleshooting if an error occurs. The terminal has 
different means of status signaling, to help you find the cause of a problem:

• Indicators.

• Event messages.

• Event log.

Indicators, event messages and logs are described in the following sections.

Light indicators

Overview

The terminal has a number of LEDs, placed in the panel at the top of the 
terminal:

• a green Power indicator,

• a green/red/ orange Terminal indicator,

• a green/red/orange Antenna indicator,

• a green Message indicator and

• 3 LAN indicators for each LAN interface, showing Activity (Green), 
Link/Speed (Green/Yellow) and PoE (Green/Red).
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General status indicator functions

Power indicator

Terminal indicator

Behavior Meaning

Green Power OK.

Flashing green The terminal is powering up.

Flashing orange The terminal is closing down.

Off No power.

Behavior Meaning

Steady green Ready. BGAN registration completed.

Flashing green Please wait - process in progress. 
BGAN registration ongoing.

Orange Warning - temporary malfunction. User action is 
required.

Red Alarm - return the unit for repair.
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Antenna indicator

Message indicator

Behavior Meaning

Steady green Tracking. The antenna is ready for use.

Flashing green Please wait - process in progress. 

Slow flashing: The antenna is starting up

Rapid flashing: Sky scan

Orange Warning - temporary malfunction. User action is 
required.

Red Alarm - return the unit for repair.

Behavior Meaning

Flashing green A new SMS message has arrived.

Off No new messages, or the unit is off.
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LAN indicator functions

Activity indicator

Link/Speed indicator

PoE indicator

Behavior Meaning

Flashing green The LAN port is active.

Behavior Meaning

Green Link speed is 100 Mbps.

Yellow Link speed is 10 Mbps.

Off The link is down.

Behavior Meaning

Green The terminal is supplying power to the LAN port.

Red The connected device requires more power than 
the terminal can supply to the LAN port.

Off The terminal is not supplying power to the port.
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Event messages

Display of event messages

The terminal can detect events during POST (Power On Self Test) or CM 
(Continuous Monitoring). When the terminal detects an event that requires 
your action, it issues an event message.

When your terminal issues an event 
message, the Terminal indicator or 
the Antenna indicator in the LED 
panel on top of the terminal signals 
the event, according to the tables 
Terminal indicator and Antenna 
indicator in the previous section.

You can see the active event messages in the web interface by clicking the 
warning symbol in the icon bar at the top in the web interface.

All events are logged in the event log. For information on the event log, see 
Viewing the Event list or the Event log on page 114.
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Logging of events

Diagnostic report

When contacting Thrane & Thrane for support, please include a diagnostic 
report. 
The diagnostic report contains information relevant for the service personnel 
during troubleshooting. 

To generate the diagnostic report, access the web interface and select 
HELPDESK. Then click Generate report. 

Event log

The event log holds information of events registered in the terminal or 
antenna. The same events are also indicated in the Antenna and Terminal 
LEDs on the terminal LED panel.

The log includes the time of the occurrence, a short description, location of the 
error etc. This information can help troubleshooting errors in the system. You 
can see the event log in the web interface. For further information, see 
Viewing the Event list or the Event log on page 114.
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Reset button

How to access the Reset button

The terminal has a Reset button placed next to the SIM slot behind the SIM 
cover. The functions of this button is described in the next section.

To press the Reset button, use a pointed device.
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Function of the Reset button

The Reset button on the terminal has the following functions:

Action Function

With the terminal 
running, press the 
Reset button 
normally.

The terminal IP address and IP netmask are 
temporarily set to the default value (default IP 
address: 192.168.0.1). 

With this function, even if the IP address has been 
changed and you do not remember the new IP 
address, you can still access the web interface and 
see your current configuration. The default value is 
not saved in the configuration, but is only valid until 
next reboot.

With the terminal 
running, press 
and hold the Reset 
button for 30 
seconds, until the 
Power indicator 
on the terminal is 
flashing orange.

The terminal restores factory settings and reboots the 
system.

While the terminal 
is booting, press 
and hold the Reset 
button.

For service use only! 
The bootloader initiates software upload.

Refer to the installation manual for details.
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Conformity 6

SAILOR®500 FleetBroadband

CE (R&TTE)

The SAILOR 500 FleetBroadband is CE certified (R&TTE directive) as stated in 
“Declaration of Conformity with R&TTE Directive”, enclosed in copy on the next 
page.
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SAILOR®250 FleetBroadband

CE (R&TTE)

The SAILOR 250 FleetBroadband is CE certified (R&TTE directive) as stated in 
“Declaration of Conformity with R&TTE Directive”, enclosed in copy on the next 
page.

FCC

This device complies with part 15 of the FCC Rules. Operation is subject to the 
following two conditions:

1) This device may not cause harmful interference, and 

2) this device must accept any interference received, including interference 
that may cause undesired operation.

Part 15.21
Changes or modifications not expressly approved by the party responsible for 
compliance could void the user's authority to operate the equipment.

Note The manufacturer is not responsible for any radio or TV interference 
caused by unauthorized modifications to this equipment. Such 
modifications could void the user's authority to operate the 
equipment.
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